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 3

Where to Find the Latest Information

Documentation is updated periodically. For the latest information about these products, including instrument software 
upgrades, application information, and product information, browse to one of the following URLs, look for the name of 
your product:

http://www.keysight.com/find/exm

To receive the latest updates by email, subscribe to Keysight Email Updates at the following URL:

http://www.keysight.com/find/MyKeysight

Information on preventing instrument damage can be found at:

www.keysight.com/find/PreventingInstrumentRepair

Is your product software up-to-date?

Periodically, Keysight releases software updates to fix known defects and incorporate product enhancements. To search 
for software updates for your product, go to the Keysight Technical Support website at:

http://www.keysight.com/find/techsupport

http://www.keysight.com/find/MyKeysight
http://www.keysight.com/find/PreventingInstrumentRepair
http://www.keysight.com/find/PreventingInstrumentRepair
http://www.keysight.com/find/PreventingInstrumentRepair
http://www.keysight.com/find/techsupport
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Keysight Wireless Test Set
E6640A EXM Wireless Test Set

Getting Started Guide

1 Quick-Start

This section explains how to initialize the test set and generate and view a 
signal.

“About the Test Set” on page 12

“Initial Inspection” on page 16

“Test Set Location and Mounting Requirements” on page 18

“Separate Application Interfaces” on page 19

“Desktop Icons” on page 22

“Turning on the test set the first time” on page 27

“Options and Licenses” on page 32

“Anti-Virus Software and Firewalls” on page 36

“Shortening the Test Set Power-On Time” on page 36

“Instrument Safety & Environmental Information” on page 37
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Quick-Start
About the Test Set

About the Test Set
The E6640A EXM Wireless Test set contains one to four Keysight M943xA 
TRXs. The specific TRX model number is dependent on the options and 
applications ordered with the test set: 

— M9432A (Option 2FD) has 2 half-duplex and 2 full-duplex ports.

— M9433A (Option 4FD) has 4 full-duplex ports.

Two older TRX models are no longer being manufactured, but it is usually 
possible to repair and recalibrate them if necessary: M9430A (2 half-duplex and 
2 full-duplex ports), and M9431A (4 full-duplex ports).

The M9432A TRX is not currently supported by the 5G NR test application.
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Quick-Start
About the Test Set

Elements of the TRX

Each TRX contains the full set of hardware elements illustrated below. Two 
separate examples are shown, for models M9432A (Option 2FD) and M9433A 
(Option 4FD).

Figure 1-1 TRX elements

Each TRX is run by its own instance of the XSA firmware application. A fully 
loaded test set shows four independent XSA windows on its monitor display. 

The TRX includes a signal analyzer and a signal source, both of which interface 
with the front panel of the test set through an input/output matrix, and each of 
which is controlled by an independent list sequencer (the two sequencers 
exchange trigger signals to coordinate their operations). 
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Quick-Start
About the Test Set

Input/Output Matrix (M9432A, Option 2FD)

The input/output matrix is illustrated below, for the M9432A TRX. Ports RFIO 1 
and RFIO2 are full-duplex ports (simultaneously inputs and outputs). Ports RF3 
I|O and RF4 I|O can be inputs or outputs, but not simultaneously.

Figure 1-2 M9432A input/output matrix

See “Port Configuration” on page 98 for more information. 
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Quick-Start
About the Test Set

Input/Output Matrix (M9433A, Option 4FD)

The input/output matrix is illustrated below, for the M9433A TRX. Ports RFIO 1 
through RFIO4 are full-duplex ports (simultaneously inputs and outputs). .

Figure 1-3 M9433A input/output matrix

See “Port Configuration” on page 98 for more information. 
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Quick-Start
Initial Inspection

Initial Inspection
Inspect the shipping container and the cushioning material for signs of stress. 
Retain the shipping materials for future use, as you may wish to ship the test 
set to another location or to Keysight Technologies for service.

Item Deliverable Notes

Keysight Model E6640A EXM Wireless Test Set

 USB keyboard & mouse A keyboard and mouse for communication with 
the controller and measurement applications. 
(These accessories are provided only if options 
E6640A-KYB and E6640A-MSE are ordered.)

Monitor cable adapter 
(Display Port to VGA)

An adapter for the front panel Display Port 
which makes it possible to use the test set with 
a monitor which has a VGA connector.

Software Entitlement 
Certificates

Redemption certificates for the measurement 
options purchased. 

Power cable Connection for test set power. 
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Quick-Start
Initial Inspection

Shipping problems?

If the shipping materials are damaged or the contents of the container are 
incomplete:

— Contact the nearest Keysight Technologies office. 
— Keep the shipping materials for the carrier’s inspection.
— If you must return an test set to Keysight Technologies, use the original (or 

comparable) shipping materials. See “Returning a test set for Service” on 
page 183.
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Quick-Start
Test Set Location and Mounting Requirements

Test Set Location and Mounting Requirements

Locating the test set

Make sure that the fan inlet and exhaust vent areas on the sides, bottom, and 
back of the test set chassis are not obstructed. The minimal required clearance 
is 1 inch (25 cm). Airflow restrictions cause additional airflow noise and cause 
the fans to speed up so they can draw in enough air for the required cooling 
resulting in excessive audible noise.

It is recommended to orient the instrument horizontally (as illustrated below), 
not vertically, and at least half a meter above the floor.

Cooling and rack mounting

Do not mount the test set side-by-side with any other instrument with 
side-by-side ventilation. Make sure the exhaust air from one instrument is 
directed away from the inlet of any other instrument (heated air directed into 
the inlet of an instrument can cause instrument failure due to excessive 
operating temperatures). The test set draws air in from the sides and bottom of 
the chassis and exhausts air from the back.

Figure 1-4 EXM front panel view
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Quick-Start
Separate Application Interfaces

Separate Application Interfaces
There are two different interfaces available for test applications which run on 
the EXM (the newer MultiTouch interface and the older Traditional interface). 
Any TRX can be set up to use either interface. 

Figure 1-5 Traditional interface and MultiTouch interface

Because there are some differences in menu structure between the two 
interfaces, many EXM procedures are performed in a slightly different way, 
depending on which of the two interfaces a TRX is running. 

The MultiTouch interface is the recommended choice, because its menus are 
easier to navigate. 

SCPI commands to a TRX are the same regardless of which interface it is 
running.

This guide describes procedures primarily with reference to the MultiTouch 
interface. However, alternative instructions are also provided, where necessary, 
for users who prefer to use the Traditional interface.
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Quick-Start
Separate Application Interfaces

MultiTouch Interface

The MultiTouch interface features a set of menus accessible from the right 
pane of the display. Many of the menu selections open a temporary 
configuration window (for example, the window for setting the RF power level 
shown in the illustration below).

Figure 1-6 MultiTouch Interface

In addition to the menus, the interface also provides a set of System setting 
windows and a Preset menu, accessed by means of the gear icon and the 
green-flash icon at the top right section of the application window.

Figure 1-7 MultiTouch system & preset icons
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Quick-Start
Separate Application Interfaces

Traditional Interface

The Traditional interface also displays menus in the right pane, but in this case 
the menu must be selected from a Virtual Front Panel popup window. This 
window is accessed by right-clicking on the display and selecting Utility > 
Virtual Front Panel in the temporary menu which appears.

Figure 1-8 Traditional interface

Once a menu has been selected, it appears in the right pane of the display 
(however, not all menu items are shown at once; use the More key at the 
bottom of the menu pane to find any menu selections which are not 
immediately visible). 



 22                                                                                                                                          Getting Started Guide

Quick-Start
Desktop Icons

Desktop Icons
Four desktop icons provide access to utilities which support the E6640A’s 
measurement firmware.

Click the Configure Applications icon to specify which measurements are to be 
loaded and run at launch. (This is for the Traditional interface.) Or: click the 
Configure Applications MultiTouch UI icon to specify which measurements 
are to be loaded and run at launch. (This is for the MultiTouch interface.) 

Figure 1-9 Desktop icons

Separate versions of the Configure Applications window are needed 
because a few of the E6640A measurement applications are supported in one 
interface but not in the other.
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Quick-Start
Desktop Icons

TRX Configurator

Use the TRX Configurator icon (at the left edge of the desktop display) to open 
the configurator. 

The TRX Configurator shows which of the four possible TRXs are installed in 
the PXIe rack, and identifies them by SCPI address. At a minimum, TRX1 must 
be installed, and cannot be disabled using this tool. However, the other TRXs, 
if installed, can be enabled or disabled using the Enable checkboxes in the xSA 
Configuration coloumn.

In the GUI Type, column, use the dropdown selector to choose the interface 
type for each of the installed TRXs (MultiTouch or Traditional).Then click 
Save. 

Figure 1-10 TRX Configurator

When you use the Launch XSA desktop icon to start the measurement 
applications, separate application windows open for each active TRX, and each 
TRX window has the type of interface you selected for it. 

The UpdateFPGA button is used when installing a new TRX into an E6640A 
which was purchased without it, to ensure software compatibility.
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Quick-Start
Desktop Icons

Launch XSA

Use the Launch XSA icon to open an application window for each TRX which is 
(1) installed and (2) enabled in the TRX Configurator. The application window 
will have whichever interface was selected for that TRX in the configurator. (In 
the example below, TRX3 is running the Traditional interface, and TRX1 is 
running the MultiTouch interface.)

Figure 1-11 Launching XSA applications

If you have closed any of the XSA application windows, you can reopen them 
without rebooting, by clicking the Launch XSA icon. This will only open a 
window for a given TRX if it is enabled in the TRX Configurator.

Minimized windows can be reopened by finding the icon representing them in 
the Windows taskbar.

Figure 1-12 Reopening minimized windows
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Quick-Start
Desktop Icons

Configure Applications 

Click the Configure Applications icon to launch this utility, which allows you to 
specify which of the E6640A’s X-series measurement applications will be 
preloaded into memory at startup. Preloading the most frequently-used 
applications is a convenience (however, selecting fewer of them for preload 
shortens the startup time and uses less memory).

Configure Applications (MultiTouch Interface)

Click the Configure Applications icon to launch this utility, which allows you to 
specify which of the E6640A’s X-series measurement applications will be 
preloaded into memory at startup. Preloading the most frequently-used 
applications is a convenience (however, selecting fewer of them for preload 
shortens the startup time and uses less memory).

If an application is not listed here, this indicates that the application is not 
supported by the MultiTouch interface.

Figure 1-13 Configure Applications MultiTouch 

Use the selection table to specify which application will be running when the 
E6640A starts up. 

Applications which are not pre-loaded at startup can be loaded later if needed, 
simply by making the necessary mode/measurement selections.
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Quick-Start
Desktop Icons

Configure Application (Traditional Interface)

This version of the Configure Applications window is specific to the 
Traditional interface; see the following page for the MultiTouch interface 
version. If an application is not listed here, this indicates that the application is 
not supported by the Traditional interface.

Figure 1-14 Configure Applications

Use the selection table to specify which application will be running when the 
E6640A starts up. 

Applications which are not pre-loaded at startup can be loaded later if needed, 
simply by making the necessary mode/measurement selections.
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Quick-Start
Turning on the test set the first time

Turning on the test set the first time

Initializing the test set

During the initial power-on process, the test set turns off and restarts several 
times. This only happens during the initial installation process.

This procedure requires that a monitor, keyboard, and mouse are connected ot 
the E6640A.

Item Deliverable Notes

1 Connect a mouse and 
keyboard

Connect the mouse and 
keyboard to two of the USB 
ports on the front panel of the 
test set. 

2 Connect a monitor Connect the monitor to the 
monitor port on the front panel 
of the test set. 

Model E6640A has no display; an external monitor is 
required.

See “Virtual Front Panel” on page 28.

3 Power on the test set Position the test set so you have 
easy access to the power cord 
and plug it in.

Press the power switch (located 
near the top right corner of the 
PXI rack) to turn the test set on.

See “Test Set Location and Mounting 
Requirements and “Power requirements” on 
page 37 for more details.

The test set can require more than 5 minutes to power-on. 
This is affected by Windows start-up requirements.

The Keysight Technologies screen appears.

At this time, it is safe to turn off the test set before starting 
the Setup Wizard.

4 Launch Microsoft 
Setup Wizard

Highlight Microsoft Windows 
and press Enter to start the 
pre-installed operating system. 



 28                                                                                                                                          Getting Started Guide

Quick-Start
Turning on the test set the first time

The analyzer performs the following steps:

• Windows Startup window

• Black screen

• Windows message window, “Please wait while windows prepares to setup”

• Keysight window 

At this time, it is safe to turn off the instrument before initializing the software.

 After launching the setup, do not turn off the instrument or remove power before the Setup 
Wizard completes and the system restarts. Turning off the instrument may corrupt the system 
and the application may not operate. 

5 Reboot and log on Click OK. When the instrument restarts, the following message 
window appears:

The system reboots.

Several required processes continue.

The system reboots.

The XSA application initializes

6 Separate instances of the application are launched for each TRX installed in the PXI rack (they are identified as “TRX1” 
through “TRX4” in the upper left corner of the application window). The verification procedures which follow should be 
done for all TRXs in the rack. (The following figures show the visual differences between the two possible interfaces.)

Item Deliverable Notes
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Quick-Start
Turning on the test set the first time

7 Verify the installation 
(Traditional Interface

From the mouse right-click 
menu, select Utility > 
Virtual Front Panel. (All 
key-presses that follow refer 
initially to a key shown on the 
Virtual Front Panel, and then 
to whatever menu keys that key 
makes available.) 

Press System > Show > 
System.

Verify that the purchased 
application(s) appear in the list.

If you require further assistance, contact the Keysight 
support team. 
Online assistance: http://www.keysight.com/find/assist

8 Verify the installation 
(MultiTouch Interface)

Open the System window by 
clicking on the gear icon

Press System > Show 
System.

Verify that the purchased 
application(s) appear in the list.

If you require further assistance, contact the Keysight 
support team. 
Online assistance: http://www.keysight.com/find/assist

9 Attach a loopback 
cable

Use an RF cable to connect the 
front panel RFIO 1 and RFIO 2 
ports for this TRX.

The purpose is to use a loopback cable to verify that the 
test set’s source can generate a signal and the test set’s 
analyzer can measure it.

Item Deliverable Notes

http://www.keysight.com/find/assist
http://www.keysight.com/find/assist
http://www.keysight.com/find/assist
http://www.keysight.com/find/assist
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Quick-Start
Turning on the test set the first time

10 Generate and view a 
signal (Traditional 
interface)

Press Input/Output > RF 
Input > RF Input Port >   
RFIO 1.

Press Input/Output > 
More > RF Output & 
Test Set Config > RF 
Output Port > RFIO 2.

Press AMPTD Y Scale >  
Ref Value > 10 > dBm.

Press FREQ > Center Freq 
>  2.4 > GHz.

Press SPAN X Scale > 
Span > 8 > MHz.

Press Source > Frequency 
> 2.4 > GHz.

Press Source > RF Output 
> On.

Press Source > 
Amplitude > RF Power > 
-15 dBm.

Press Peak Search.

Select RFIO 1 as the input port

 
 
Select RFIO 2 as the output port.

 
 
 
 
Set the amplitude reference to 10 dBm

 
Set the analyzer center frequency to 2.4 GHz.

 
Set the analyzer span to 8 MHz.

 
Set the source frequency to 2.4 GHz.

 
Set the source RF output to On. 
 

Set the source amplitude to -15 dBm.

To ensure accurate power levels from the source, see 
“Alignments” on page 36.

The 2.4 GHz signal appears on the display.

Item Deliverable Notes
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Quick-Start
Turning on the test set the first time

11 Generate and view a 
signal (MultiTouch 
interface)

Press Input/Output > 
Input > RF Input Port,  
RFIO 1.

Press Input/Output > RF 
Source > RF Output 
Port, RFIO 2.

Press Amplitude > 
Scale/Div > 10 > dB.

Press Frequency > Center 
Frequency > 2.4 > GHz.

Press Frequency > Span > 
8  > MHz.

Press Input/Output > 
Frequency > 2.4 > GHz.

Press Input/Output > RF 
Source > RF Output > 
On.

Press Input/Output > RF 
Source > RF Power > 15 
> -dBm.

Press Peak Search > Peak 
Search.

Select RFIO 1 as the input port

 
 
Select RFIO 2 as the output port.

 
 
 
Set the amplitude reference to 10 dBm

 
Set the analyzer center frequency to 2.4 GHz.

 
Set the analyzer span to 8 MHz.

 
Set the source frequency to 2.4 GHz.

 
Set the source RF output to On. 
 
 

Set the source amplitude to -15 dBm. 
 

To ensure accurate power levels from the source, see 
“Alignments” on page 36.

The 2.4 GHz signal appears on the display.

Item Deliverable Notes
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Quick-Start
Options and Licenses

Options and Licenses

Checking Options (MultiTouch Interface)

The options and licenses installed on the test set are listed on the System > 
Show System display, as illustrated below. Certain features of the test set 
(such as its frequency range, its analysis bandwidth, the measurement 
applications it runs, and in some cases individual measurements within an 
application) are licensed features, and are unavailable if the appropriate license 
is not installed. 

Figure 1-15 Checking options (MultiTouch)

Hardware-related options such as frequency range and analysis bandwidth are 
specific to the TRX; measurement applications apply to any TRX in the same test 
set chassis.
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Checking Options (Traditional Interface)

The options and licenses installed on the test set are listed on the System > 
Show > System display, as illustrated below. Certain features of the test set 
(such as its frequency range, its analysis bandwidth, the measurement 
applications it runs, and in some cases individual measurements within an 
application) are licensed features, and are unavailable if the appropriate license 
is not installed. 

Figure 1-16 Checking options (Traditional)

Hardware-related options such as frequency range and analysis bandwidth are 
specific to the TRX; measurement applications apply to any TRX in the same test 
set chassis.
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Option 2FD

Option 2FD modifies the RFIO interface of the E6640A EXM Wireless Test Set 
as follows:

— Each TRX in the test set has a model designation M9432A.

— Ports RFIO 1 and RFIO2 are full-duplex ports (simultaneously inputs and 
outputs). Ports RF3 I|O and RF4 I|O are half-duplex ports (they can be 
inputs or outputs, but not simultaneously).

— Performance characteristics for the four ports are described in the E6640A 
EXM Wireless Test Set Data Sheet.

— Port settings found under the Input/Output menu (and equivalent SCPI 
commands) reflect the options installed.

See “Port Configuration” on page 98 for more information. 

Option 4FD

Option 4FD modifies the RFIO interface of the E6640A EXM Wireless Test Set 
as follows:

— Each TRX in the test set has a model designation M9433A.

— All four ports (RFIO 1, RFIO 2, RFIO 3, and RFIO 4) on each module are 
full-duplex ports (that is, any port can be used simultaneously as an RF 
input (to the test set’s analyzer) and as an RF output (from the test set’s 
source).

— Any of the TRX’s four RFIO ports can be configured as a full duplex port; it 
can also be configured as an input port (accepting a signal to be analyzed), 
with a separate port configured as an output port (providing an RF 
stimulus).  

— Performance characteristics for all four ports are same as those described 
for ports RFIO 1 and RFIO 2 in the E6640A EXM Wireless Test Set Data 
Sheet.

— Port settings found under the Input/Output menu (and equivalent SCPI 
commands) reflect the options installed.

See “Port Configuration” on page 98 for more information.
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Frequency Range Options

Option E6640A-504 
380 MHz to 3.8 GHz (cellular communications)

Option E6640A-5WC 
1.1 to 1.8, 2.3 to 2.6, and 4.8 to 6 GHz (wireless connectivity)

Option E6640A-506 
380 MHz to 6 GHz (cellular communications and wireless connectivity) 

Option E6640A-5B0 (required for 5G NR testing) 
380 MHz to 6 GHz with 5G NR bands (cellular communications and wireless 
connectivity) 

Option E6640A-5LF 
76-110 MHz and 207-222 MHz (Tx only)  

Bandwidth Options

(Standard bandwidth is 40 MHz.)

Option E6640A-B1X (required for 5G NR testing) 
160 MHz bandwidth

MIMO Options

Option E6640A-M22  
Up to 2x2 True MIMO

Option E6640A-M33  
Up to 3x3 True MIMO

Option E6640A-M44 
Up to 4x4 True MIMO
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Anti-Virus Software and Firewalls
No anti-virus software is shipped with the test set. It is recommended that you 
install anti-virus software if your test set is connected to the LAN. Check with 
your IT department to see what they recommend. 

The test set is shipped with the Windows firewall enabled. Do not modify the 
default network settings as this may cause problems with the operating system 
of the test set.

Keysight recommends installing Windows updates. This should be enabled in 
Windows security settings.

Shortening the Test Set Power-On Time

You can set the configuration to pre-load only the applications that you 
typically run. This can significantly shorten the time it takes for your test set to 
power-on. See “Configure Applications” on page 25 for more information.

If (after power-on) you want to access an application that you did not pre-load, 
it will take a little longer to bring it up once you press the application softkey. 
This longer time-frame is only for the first access after power-on. After the 
initial access, mode (application) switching will operate as quickly as if the 
application had been pre-loaded.
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Instrument Safety & Environmental Information

Power requirements

The only physical installation of your Keysight test set is a connection to a 
power source. Line voltage does not need to be selected. 

This test set does not contain customer serviceable fuses.

This is a Safety Class 1 Product (provided with a protective earthing ground 
incorporated in the power cord). The mains plug shall only be inserted in a 
socket outlet provided with a protective earth contact. Any interruption of the 
protective conductor inside or outside of the product is likely to make the 
product dangerous. Intentional interruption is prohibited. (IEC 348 clauses 
17.3.3c & 17.3.4)

Failure to ground the test set properly can result in personal injury. Before 
turning on the test set, you must connect its protective earth terminals to the 
protective conductor of the main power cable. Insert the main power cable plug 
into a socket outlet that has a protective earth contact only. DO NOT defeat the 
earth-grounding protection by using an extension cable, power cable, or 
autotransformer without a protective ground conductor.

This product is designed for use in Installation Category II and Pollution Degree 
2.  
 
This instrument has autoranging line voltage input. Before switching on the 
instrument, be sure the supply voltage is within the specified range.

The Mains wiring and connectors shall be compatible with the connector used in 
the premise electrical system. Failure, to ensure adequate earth grounding by 
not using the correct components may cause product damage, and serious 
injury.



 38                                                                                                                                          Getting Started Guide

Quick-Start
Instrument Safety & Environmental Information

AC power cord

The test set is equipped with a three-wire power cord, in accordance with 
international safety standards. This cable grounds the test set cabinet when 
connected to an appropriate power line outlet. The cable appropriate to the 
original shipping location is included with the test set. See:

 http://www.keysight.com/find/powercords

Environmental Conditions (Operating)

This product is designed for use in the following conditions: 

— For indoor use only

— Temperature 5°C to 45°C 

— Altitude up to 3000 meters

— 0% Relative Humidity to 90% Relative Humidity up to 40°C, and linearly 
decreasing to 50% Relative Humidity up to 45°C; non-condensing.

Always use the three-prong AC power cord supplied with this product. Failure to 
ensure adequate earth grounding by not using this cord can cause product 
damage. 

This instrument has auto-ranging line voltage input; be sure the supply voltage 
is within the specified range and voltage fluctuations do not to exceed 10 
percent of the nominal supply voltage:

100/120 VAC 50/60 Hz, 1000 W MAX 
220/240 VAC 50/60 Hz, 1200 W MAX.

If this product is not used as specified, the protection provided by the 
equipment could be impaired. This product must be used in a normal condition 
(in which all means for protection are intact) only. 
Install the instrument so that the detachable power cord is readily identifiable 
and easily reached by the operator. The detachable power cord is the 
instrument disconnecting device. It disconnects the mains circuits from the 
mains supply before other parts of the instrument. The front panel switch is only 
a standby switch and is not a LINE switch. Alternatively, an externally installed 
switch or circuit breaker (which is readily identifiable and is easily reached by 
the operator) may be used as a disconnecting device.

This product is designed for use in Installation Category II and  
Pollution Degree 2.

http://www.keysight.com/find/powercords
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EMC (Electromagnetic Compatibility)

This product complies with the essential requirements of the European EMC 
Directive and the UK Electromagnetic Compatibility Regulations 2016, as well 
as current editions of the following standards (dates and editions are cited in 
the Declaration of Conformity): 

— IEC/EN 61326-1

— CISPR Pub 11 Group 1, class A

— AS/NZS CISPR 11

— ICES/NMB-001 
This ISM device complies with Canadian ICES-001. 
Cet appareil ISM est conforme a la norme NMB-001 du Canada.

South Korean Class A EMC declaration

This equipment is Class A suitable for professional use and is for use in 
electromagnetic environments outside of the home.

Declaration of Conformity

The Declaration of Conformity for any Keysight product can be found on the 
website: 
http://www.keysight.com/go/conformity

This equipment is not intended for use in residential environments and may not 
provide adequate protection to radio reception is such environments.         

http://www.keysight.com/go/conformity
http://www.keysight.com/go/conformity
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Ventilation 

Instrument Maintenance

Cleaning the instrument

Cleaning the connectors

VENTILATION REQUIREMENTS:  When installing the product in a cabinet, the 
convection into and out of the product must not be restricted.  The ambient 
temperature (outside the cabinet) must be less than the maximum operating 
temperature of the product by 4oC for every 100 watts dissipated in the 
cabinet. If the total power dissipated in the cabinet is greater than 800 watts, 
then forced convection must be used.

To prevent electrical shock, disconnect the test set from mains before cleaning. 
Use a dry cloth or one slightly dampened with water to clean the external case 
parts. Do not attempt to clean internally.

Cleaning connectors with alcohol shall only be done with the instrument power 
cord removed, and in a well-ventilated area. Allow all residual alcohol moisture 
to evaporate, and the fumes to dissipate prior to energizing the instrument.
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Battery Information

The test set uses a lithium battery located on the CPU board. This is not an 
operator replaceable part. See “Returning a test set for Service” on page 183. 
Replaceable parts must be approved or supplied by Keysight Technologies.

You can order the service documentation for the instrument through your 
Keysight Sales and Service office. 

Danger of explosion if battery is incorrectly replaced. Replace only with the same 
or equivalent type recommended. Discard used batteries according to the 
manufacturer’s instructions. 
 
Do not throw batteries away but collect as small chemical waste.
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Protecting against electrostatic discharge

Electrostatic discharge (ESD) can damage or destroy electronic components 
(the possibility of unseen damage caused by ESD is present whenever 
components are transported, stored, or used).

Test equipment and ESD

To help reduce ESD damage that can occur while using test equipment: 

• Before connecting any coaxial cable to a test set connector for the first time 
each day, momentarily short the center and outer conductors of the cable 
together.

• Personnel should be grounded with a 1 MΩ resistor-isolated wrist-strap 
before touching the center pin of any connector and before removing any 
assembly from the test set.

• Be sure that all instruments are properly earth-grounded to prevent 
build-up of static charge.

• Perform work on all components or assemblies at a static-safe workstation.

• Keep static-generating materials at least one meter away from all 
components.

• Store or transport components in static-shielding containers.

• Always handle printed circuit board assemblies by the edges. This reduces 
the possibility of ESD damage to components and prevent contamination of 
exposed plating.

Additional information about ESD

For more information about ESD and how to prevent ESD damage, contact the 
Electrostatic Discharge Association (http://www.esda.org). The ESD standards 
developed by this agency are sanctioned by the American National Standards 
Institute (ANSI).

Do not use these first three techniques when working on circuitry with a voltage 
potential greater than 500 volts.
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2 Front and Rear Panel Features

The following topics can be found in this section:

“Front Panel Features” on page 44

“Rear Panel Features” on page 57

“Front and Rear Panel Symbols” on page 58
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Front Panel Features
The test set consists of instruments loaded in a PXI rack, hidden behind a front 
panel. There is a controller (located on the far left), and one to four TRX 
(transmit/receive) sub-instruments, each of which includes an RF signal 
generator and an RF signal analyzer. A frequency-reference instrument, shared 
by all the TRX sub-instruments, is placed in the center. 

Figure 2-1 EXM Front Panel
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Controller Hardware Interface

The controller’s front panel features are illustrated below:  

Figure 2-2 Controller front panel

 

Number Item Name Description

1 Monitor Port This connector supports a connection to a monitor with a DisplayPort input.

2 LED Indicators — DRIVE: When the Solid State Drive is active, the LED will flash.

— POWER: If the LED is on, the power supply to the controller is 
good and the system should boot.

— USER: Not used.

3 TRIG This trigger line is not used by the E6640A.
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4 LAN Connectors Two TCP/IP Interface connectors that are used for remote test set operation. 
Choose the LAN 1 port to have an IP address assigned to the test set 
dynamically, using DHCP. If your local network does not support DHCP, choose 
the LAN 2 port to use a private static IP address. (See “LAN Address 
Configuration” on page 105.) 

5 USB 3.0 The controller provides two USB 3.0 ports.

6 USB 2.0 The controller provides four USB 2.0 ports.

Number Item Name Description
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TRX Module Hardware Interface

There can be as many as four TRX modules in the PXI rack; each has the same 
hardware interface, as illustrated below.  

Figure 2-3 TRX module front panel

 

If the E6640A test set was purchased with Option 4FD, all four 
RF ports have full-duplex capability, therefore two of the ports 
are labeled and used differently than they are described below. 
See “Option 4FD” on page 14.

Number Item Name Description

1 TRXn STATUS When the PXI chassis is powered on, the STATUS LED for each TRX module lights 
red when the software application controlling the TRX hardware begins loading. 
When the software application is done loading, the LED will be green the TRX will 
be ready for use.

2 RFIO 2 This Type N connector is a full-duplex RF input/output port.

3 RFIO 1 This Type N connector is a full-duplex RF input/output port.
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4 TRIG OUT 2 A trigger output used to synchronize other test equipment with the test set. 
Configurable from the Input/Output keys.

5 TRIG IN 1 A trigger input used to synchronize other test equipment with the test set. 
Configurable from the Input/Output keys. 

6 RF4 I/O This Type N connector is a half-duplex RF port which can be configured as an 
input or an output. (If Option 4FD is installed, see “Option 2FD” on 
page 34.)

8 RF3 I/O This Type N connector is a half-duplex RF port which can be configured as an 
input or an output. (If Option 4FD is installed, see “Option 2FD” on 
page 34.)

9 TRIG OUT 1 A trigger output used to synchronize other test equipment with the test set. 
Configurable from the Input/Output keys.

10 TRIG IN 2 A trigger input used to synchronize other test equipment with the test set. 
Configurable from the Input/Output keys. 

Number Item Name Description
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Reference Module Hardware Interface

The connectors which are exposed when the impact cover is in place are 
illustrated below: 

Figure 2-4 Reference module front panel

 

Number Item Name Description

1 10 MHz OUT This BNC input port provides a timebase reference output from the M9300A 
Reference module.

2 REF IN This BNC input port accepts a timebase reference input to the Ref In port of the 
M9300A Reference module.
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Virtual Front Panel (Traditional Interface)

The E6640A model does not include physical front-panel keys. However, if you 
have a PC mouse, monitor, and keyboard plugged in (or are working through a 
Remote Desktop interface), you can navigate front-panel functions using the 
virtual front panel (VFP) shown below. Access the VFP as follows: 

1. Right-click the mouse. 

2.  Left-click Utility (1) in the menu, as shown below. 

3. Left-click Virtual Front Panel (2) in the menu, as shown below. 

Figure 2-5 Accessing the virtual front panel

On the VFP the keys labeled SoftKey 1 through SoftKey 7 function as the 
menu keys. Using the mouse to click on a combination of the VFP keys and the 
menu keys on the display screen, you can operate the instrument as if it had 
conventional front-panel keys. The VFP frame shows the TRX number at the 
upper left corner of the frame, so that it’s clear which sub-instrument within 
the PXI rack is being controlled by it. 

The PC mouse and monitor are required when using the E6640A. For ease in 
using the VFP, the PC keyboard is recommended.



Getting Started Guide                                                                                                                                          51

Front and Rear Panel Features
Front Panel Features

Figure 2-6 VFP keys

The VFP window is not used in the MultiTouch interface, 
because that interface makes all menus and functions available 
from the main display screen.
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When the Test Set is Controlled Remotely

The test set can be controlled remotely, from another computer. (See “Remote 
Desktop: Using the Test Set Remotely” on page 187.) When the test set is 
being controlled remotely, a log-on screen is displayed on the monitor. f

Under these circumstances, pressing the front-panel Power switch does not 
immediately turn instrument power off. Instead, the following message 
appears:

Other people are logged on to this computer. Shutting down windows 
might cause them to lose data. Do you want to continue shutting 
down?

Although pressing and holding down the Power button will force a power 
shutdown, this is not recommended; use the Windows shutdown function 
instead.

Do not shut down power by pulling out the power plug; this will damage the 
power supply.
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Display Annotations (MultiTouch interface)

Figure 2-7 Display annotations (XSA MultiTouch interface)

 

Number Description Notes

1 The TRX sub-instrument associated with the 
application (identified as “TRX1” through 
“TRX4”).  

This is needed because the E6640A can include up to four 
independent TRX sub-instruments in one PXI rack.

2 Screen tab. Shows mode and measurement 
selected for that tab. 

To change the selection, click on the tab to open the 
Mode/Meas/View dialog.

3 Add another screen tab. Click to add another screen tab for this TRX; can be set to 
another mode and measurement.

4 Measurement bar. Shows the most important parameters for the 
measurement.

5 System Settings icon. Click to open a complex System Settings window, which 
provides access to many settings which are independent of 
a particular measurement (alignments, for example).

6 Menus. Measurement settings menus and submenus.
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7 Preset icon. Access to presets and defaults.

8 Left side of measurement bar; includes display 
of pass/fail result, plus single/continuous 
measurement selection and indicator.

The following graphics indicate single/continuous 
measurement:

9 Measurement results. Graphs plus numerical tables; the number and type of 
displays is determined by the measurement that is 
running.

10 Undo/Redo icons. Undo the last excuted function, or redo the last undone 
function.

11 Windows icon. Open the Windows Start menu and taskbar.

12 File icon. Access to a variety of file-related functions, including Save 
and Recall.

13 Help icon. Open the help content. To dismiss the help, use the ESC 
key or the X at the upper right of the help screen.

14 Status window. Displays status messages.

15 Block diagram. Opens a graphical representation of internal hardware and 
signal paths. Individual blocks can be clicked to open 
related menus.

16 View editor. Opens an editor for adding and deleting windows, resizing 
and rearranging windows, and creating User Views.

17 Multiscreen icon. Displays all the existing screen tabs simultaneously, in 
multiple windows.

18 Fullscreen icon. Expand the measurement window horizontally over the 
entire instrument display. The screen graticule area 
expands to fill the available display area.

Number Description Notes
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Display Annotations (Traditional Interface)

Figure 2-8 Display annotations (XSA interface)

 

Number Description Function Key

1 Measurement bar; shows general measurement 
settings and information. Some measurements 
include limits which the data is tested against. A 
Pass/Fail indication may be shown in the lower-left 
corner. The following graphics indicate 
single/continuous measurement:

All the keys in the test set Setup part of the front 
panel.

2 Active Function (measurement bar); when the current 
active function has a settable numeric value, it is 
shown here.

Currently selected front panel key.

3 The TRX sub-instrument associated with the 
application (identified as “TRX1” through “TRX4”). This 
is needed because the E6640A can include up to four 
independent TRX sub-instruments in one PXI rack.
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4 Banner; shows the name of the selected application 
that is currently running.

Mode

5 Measurement title; shows title information for the 
current measurement, or a title that you created for 
the measurement.

Meas

View/Display, Display, Title

6 Settings panel; displays system information that is not 
specific to any one application.

— Input/Output status - green LXI indicates 
the LAN is connected. RLTS indicate 
Remote, Listen, Talk, SRQ

— Input impedance and coupling

— Selection of external frequency reference

— Setting of automatic internal alignment 
routine

Local and System, I/O Config, Input/Output, 
Amplitude, System, and others

7 Active marker frequency, amplitude, or function value Marker

8 Settings panel; time and date display System, Control Panel

9 Trace and detector information Trace/Detector, Clear Write (W)  
Trace Average (A) Max Hold (M)  
Min Hold (m)  
Trace/Detector, More, Detector,  
Average (A) Normal (N) Peak (P) 
Sample (S) Negative Peak (p)

10 Key labels that change based on the most recent key 
press

Softkeys

11 Displays information, warning, and error messages. 
Message area: single events. Status area: conditions.

12 Measurement settings for the data currently being 
displayed in the graticule area. In the example above: 
center frequency, resolution bandwidth, video 
bandwidth, frequency span, sweep time and number 
of sweep points.

Keys in the test set Setup part of the front panel.

Number Description Function Key
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Rear Panel Features

Figure 2-9 EXM rear panel

Number Item Name Description

1 Line power input The AC power connection. See the product specifications for more details.

2 POWER SYNCH IN/OUT Reserved for future use.

3 FAN Fan speed control (settings are HIGH and AUTO).

4 INHIBIT Inhibit switch. The settings are DEF (default) and MAN (manual). 

— When the switch is in the default position, the chassis is powered 
up by the front panel ON/Standby pushbutton. This is the 
recommended setting.

— When the switch is in the manual position, the chassis is powered 
up by the Inhibit input signal on the rear panel INHIBIT/VOLTAGE 
MON DB-9 connector.

5 INHIBIT/VOLTAGE MON This DB-9 connector provides access for testing of internal power supply 
voltages. The voltages (by Pin #) are: (1) Logic Gnd, (2) +5 VDC, (3) Rsrvd, (4) 
+3.3 VDC, (5) Inhibit [Low], (6) +12 VDC, (7) Rsrvd, 

(8) -12 VDC, (9) Logic Gnd.

6 10 MHz REF OUT This BNC connector is not used by the E6640A test set. The front panel 10 MHz 
OUT connector should be used instead. 

7 10 MHz REF IN This BNC connector is not used by the E6640A test set. The front panel REF IN 
connector should be used instead. 
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Front and Rear Panel Symbols
Labels and symbols which may be shown on the E6640A (mainly on the rear 
panel of the chassis) are described in the table below.

Symbol Description

This symbol marks the standby position of the power line switch.

This symbol marks the ON position of the power line switch.

This symbol marks the OFF position of the power line switch.

This symbol indicates the input power required is AC.

This symbol indicates DC voltage.

This symbol indicates a three-phase alternating current.

This symbol indicates frame or chassis terminal.

The instruction documentation symbol. The product is marked with this 
symbol when it is necessary for the user to refer to the instruction in the 
documentation.   

This symbol indicates the presence of a laser device.

This symbol indicates that the surface can be hot.   

This symbol identifies the Protective Conductor Terminal.

This symbol indicates the equipment is protected throughout by double or 
reinforced insulation.

The CE marking is a registered trademark of the European Community (if 
accompanied by a year, it is the year when the design was proven). It 
indicates that the product complies with all relevant directives. 
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UK conformity mark is a UK government owned mark. 
Products showing this mark comply with all applicable UK regulations.

The Keysight email address is required by EU directives applicable to our 
product. 

The CSA mark is a registered trademark of the CSA international.

Canada EMC label. 
Interference-Causing Equipment Standard for industrial, scientific and 
medical (ISM) equipment. Matériel industriel, scientifique et médical (ISM). 

CE/ICES/ISM label. This is a space-saver label that combines three 
markings — CE with CAN ICES (see above) and ISM (see below). 

The RCM mark is a registered trademark of the Australian Communications 
and Media Authority.

This is a combined marking to indicate product compliance with the 
Industry Canadian Interference-Causing Equipment Standard 
(ICES/NMB-001). This is also a symbol of an Industrial Scientific and 
Medical Group 1 Class A product (CISPR 11, Clause 5).

This is a symbol of an Industrial Scientific and Medical Group 1 Class A 
product (CISPR 11, Clause 5).

South Korean Certification (KC) mark. It includes the marking’s identifier 
code.

The crossed-out wheeled bin symbol indicates that separate collection for 
waste electric and electronic equipment (WEEE) is required, as obligated by 
the EU DIRECTIVE and other National legislation. Please refer to  
www.keysight.com/go/takeback for information about your 
trade-in options with Keysight, in addition to product takeback instructions. 

China Restricted Substance Product Label. The EPUP (environmental 
protection use period) number in the center indicates the time period 
during which no hazardous or toxic substances or elements are expected to 
leak or deteriorate during normal use and generally reflects the expected 
useful life of the product.  

Universal recycling symbol. This symbol indicates compliance with the 
China standard GB 18455-2001 as required by the China RoHS regulations 
for paper/fiberboard packaging.

This mark indicates product has been designed to meet the requirements of 
“IP x y”, where “x” is the solid particle protection and “y” is the liquid ingress 
protection.  

Symbol Description
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3 Test Set Operating System

The following topics can be found in this section:

“Keysight Software Installed” on page 62

“Customer Installation of Software” on page 63

“User Accounts” on page 64

“Licensing” on page 66

“Licensing New Measurement Application Software - After Initial 
Purchase” on page 68

“Transporting a License Between Test Sets” on page 70

“Windows Configuration” on page 73

“Configuring Printers” on page 76

“Configuring LAN” on page 76

“Windows Security” on page 77

“System Maintenance” on page 81

“USB Connections” on page 82

“Hard Drive Partitioning and Use” on page 84

“Hard Drive Recovery Process” on page 85
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Keysight Software Installed

Measurement Software Applications

A set of Keysight measurement applications for different modes (GSM/EDTE, 
cdma2000, Sequence Analyzer mode, etc.) is installed by default in the test 
set, but these must be licensed in order to be used. Whichever licenses were 
purchased with the instrument are installed at the factory (see “Options and 
Licenses” on page 13. Other licenses can be purchased and installed later 
(including transportable licenses). For more information, see:  
http://www.keysight.com/find/e6640a

http://www.keysight.com/find/e6640a
http://www.keysight.com/find/e6640a
http://www.keysight.com/find/e6640a
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Customer Installation of Software

3rd party software verified by Keysight

Keysight has verified that the following programs are compatible with the test 
set applications:

— Symantec AntiVirus™ Corporate Edition version 10

— MathWorks MATLAB

Installation of other 3rd party software

The E6640A platform is an open Windows environment, so you can install 
non-approved software on the test set. However, installation of non-approved 
software may affect test set performance. Keysight does not warrant the 
performance of the test set with non-approved software installed.

If you install programs other than those that Keysight has tested, it could cause 
problems with the test set's applications. If this happens, you should try 
uninstalling the program that has caused the problem, or try changing the 
program's configuration. If this does not correct the problem, you may have to 
use the Keysight Recovery system to reinstall the test set's system software.

Before installing any additional programs on the test set, you should exit the test 
set application.

Also, you must not remove any applications or programs that are installed on the 
test set when it is shipped from the factory.
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User Accounts

Administrator login

The Administrator account ships from the factory with the password 
“Keysight4u!”. Using the Administrator account, you can perform the following 
operations:

— Install software
— Configure network and printer access
— Access all files on the test set
— Add or change user accounts and passwords
— Change Firewall settings
— Change Windows settings (for example, using Device Manager)
— Change the time and date
— Run any application

User login

The default user account that ships from the factory is “Instrument” with the 
password “measure4u”. This user is a member of the Power Users group. Using 
the Instrument account you can perform the following operations:

— Install software
— Configure network and printer access
— Access files on the test set that are accessible to the Power Users group
— Run applications that are accessible to the Power Users group

The E6640A was formerly a product of Agilent Technologies. If the front panel of 
the test set shows Agilent as the manufacturer, then “agilent4u” may have been 
set as the password for the Administrator account.
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Customer creation of accounts

You can create additional user accounts and decide on the level of security 
granted to any new user accounts created. For example, the level of security 
can be assigned as administrator, power user, user, backup operators. User 
names are not case sensitive but passwords are case sensitive.

It is Keysight’s expectation that each user’s My Documents folder is mapped to 
the D: drive. This is to avoid overwriting the user’s data in the event the 
Keysight Recovery must be performed. Also, this facilitates convenient backup 
by copying the contents of the D: drive to external media. All users accounts 
created by the factory already have My Documents mapped to the D: drive. 
Please map all new users My Documents folders to the D: drive.

For the test set software to operate, the user account executing the software must 
be assigned Administrator or Power User privileges. Otherwise, the test set 
software will not operate correctly. 
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Licensed Applications

The following application licenses are available for the EXM:

Licenses Description 

V9060EM0E IQ Analyzer Measurement Application (always installed)

V9065EM0E Sequence Analyzer Downlink Application

V9065EM1E Sequence Analyzer Uplink Application (always installed)

V9071EM0E and Y9071EM0Ea GSM/EDGE/Evo Application

V9072EM0E and Y9072EM0Ea cdma2000® Application

V9073EM0E and Y9073EM0Ea WCDMA/HSPA/HSPA+ Application

V9076EM0E and Y9076EM0Ea 1xEV-DO Application

V9077EM0E and Y9077EM0Ea WLAN 802.11a/b/g/j/p/n Application

V9077EM1E and Y9077EM1Ea WLAN 802.11ac/ax Application 

V9079EM0E and Y9079EM0Ea TD-SCDMA/HSPA Application

V9080EM0E and Y9080EM0Ea LTE and LTE-Advanced FDD Application

V9080EM3E and Y9080EM3Ea NB-IoT and eMTC Application

V9080EM4E and Y9080EM4Ea LTE V2X Application

V9081EM0E and Y9081EM0Ea Bluetooth® Application

V9082EM0E and Y9082EM0Ea LTE and LTE-Advanced TDD Application

V9085EM0E and Y9085EM0Ea 5G NR Application

V9085EM1E PAvT Measurement Application 

a. Licenses beginning with a "Y" support both measurement and waveform generation; licenses beginning with a 
"V" support measurement only.
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Flexible Software Licensing 

Keysight offers a variety of flexible licensing options to fit your needs and 
budget. You have two or more options to choose from for the license term, 
license type, and KeysightCare software support subscription.

License Terms

— Perpetual:  
License can be used indefinitely.

— Time-based:  
License can be used through the term of the license only (6, 12, 24, or 36 
months).

License Types

— Node-locked:  
License can be used on one specified instrument/computer.

— Transportable:  
License can be used on one instrument/computer at a time but may be 
transferred to another using Keysight Software Manager (internet 
connection required).

— USB Portable:  
License can be used on one instrument/computer at a time but may be 
transferred to another using a certified USB dongle (available for additional 
purchase with Keysight part number E8900-D10).

— Floating (single site):  
Networked instruments/computers can access a license from a server one 
at a time. Multiple licenses can be purchased for concurrent usage.

KeysightCare Software Support Subscriptions

— Perpetual licenses are sold with a 12 (default), 24, 36, or 60-month software 
support subscription. Support subscriptions can be renewed for a fee after 
that.

— Time-based licenses include a software support subscription through the 
term of the license.

For More information

On licensing in general: 
www.keysight.com/find/licensingwww.keysight.com/find/licensing

On upgrading software: 
www.keysight.com/find/upgrade_to_software_support

www.keysight.com/find/licensing
www.keysight.com/find/licensing
www.keysight.com/find/upgrade_to_software_support
www.keysight.com/find/licensing
www.keysight.com/find/licensing
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Licensing New Measurement Application Software - After Initial 
Purchase

Additional measurement application software can be ordered after your initial 
purchase of the E6640A test set. Software upgrades are provided in a kit that 
includes an option based Entitlement Certificate, a license agreement. The 
licenses are downloaded from the license Web site onto a storage device so 
they can be loaded into the instrument.

If you do not want to wait for your upgrade kit to arrive, licenses can be 
installed using any available USB storage device. If you choose to do this, we 
recommend that the latest version of the instrument software be installed. This 
ensures that the measurement application being licensed and activated is 
installed and is the most current version.

The latest revision of the software may be downloaded from: 
http://www.keysight.com/find/e6640a

A license key is usually for one instrument model and serial number 
combination. The license key will only install itself on that instrument.

Installation procedure over USB

No calibration is required after a test set application installation.

Step Action Notes

1 Redeem the Option 
Upgrade Entitlement 
Certificate

• Follow the instructions on the 
Certificate

After redeeming your Option Upgrade 
Entitlement Certificate you will receive an 
e-mail with an attached License File.

2 Save the license file • Save the .lic file to the root directory of 
a USB storage device

3 Load the license file • Connect the USB storage device to one 
of the test set USB ports.

Windows will detect the new hardware and 
may display the configuration menu. 

The test set automatically loads the license 
file. (This may take a few minutes) Upon 
completion, the Keysight License Manager 
displays a “Successful License Installation” 
message.

Alternatively the license file can be manually installed over USB or LAN by placing the 
license file in the following folder on the test set.

C:\Program Files\Agilent\licensing

http://www.keysight.com/find/e6640a
http://www.keysight.com/find/e6640a
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4 Verify installation Cycle the power on the signal test set.

On the Virtual Front Panel press System, 
Show, System.

Verify that the new application appears in 
the list.

The application will not be available for use 
until after the power has been cycled

This displays the list of installed 
applications.

If you require further assistance, please 
contact the Keysight support team.

Online assistance: 
http://www.keysight.com/find/assist

If you do not have access to the Internet, 
contact your local Keysight Technologies 
Sales and Service Office, or if in the United 
States, call 1-800-829-4444.

Step Action Notes

http://www.keysight.com/find/assist
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Transporting a License Between Test Sets
To move a transportable license from one test set to another, Keysight 
recommends that both test sets be at the same instrument software release. 
This ensures that the user experience is identical between instruments.

As a minimum, the instrument software release in the test set that will receive 
the transportable license (the "target instrument") must at least be able to 
support the desired application.

The E6640A test sets support several ways of transporting licenses. The 
procedure below will focus on the most common procedure, where neither of 
the test sets has access to an internet connection. 

You will need the following:

— USB flash drive

— USB keyboard

— USB mouse

The test set from which the transportable license will be removed is here called 
the "source instrument". The test set which will receive the transportable 
license is here called the "target instrument".

Procedure for Transporting a License, Neither Test Set Connected to 
the Internet

The test set from which the transportable license will be removed is here called 
the "source instrument". The test set which will receive the transportable 
license is here called the "target instrument".

This procedure requires a PC with an internet connection.

Step Action Notes

1 Connect the USB devices 
to the source instrument

— Connect the USB flash drive, USB 
keyboard, and USB mouse to the 
USB ports on the source 
instrument.

It will be necessary to use one or more of 
the front panel ports to connect the USB 
devices.

2 Verify software version in 
each test set

— On the Virtual Front Panel for 
each test set, press System > 
Show > System and make note of 
the Instrument S/W Revision on 
each.

Ideally, the revisions will be the same. But at 
least, both versions should be able to 
support the application whose license is 
being transported.

3 Obtain the Host ID from 
the Target Instrument

— On the target instrument, press 
System > Show > System and 
make note of the host ID.

This information will be needed to issue the 
license for the target instrument. The Host 
ID is the model number, followed by a 
comma, followed by the serial number.
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4 Start the License Manager 
on the Source Instrument

— On the source instrument, press 
System > More> Licensing… 

— It may take a minute for the 
Keysight License Manager screen 
to be fully populated with all the 
installed licenses.

5 Transport the 
Transportable License 
from Source Instrument

— On the source instrument, locate 
the desired license to be 
transported and highlight it. Its 
option designator should include 
the letters "TP".  

— Right-click on the mouse and 
select Delete.

— Click Yes in the License Deletion 
Confirmation dialog box.

— After a few seconds, a Transport 
License dialog box will appear. 
Click OK and save the *.url files 
on the USB flash drive, with a 
name such as 
"PhaseNoise_License.url".

Be sure you are selecting a transportable 
license and not a fixed perpetual license.  
 
Although you are "deleting" the 
transportable license, the ultimate action 
will be to transport it. 
 
The information in this dialog box will be 
used to issue a new license for the target 
instrument.

6 Get New License from 
KSM Transportation Web 
page

— Insert USB flash drive into PC that 
is connected to the internet. 

— On the PC, locate the *.url file on 
the USB flash drive that was 
saved in the previous step and 
click on it.

— After a few seconds, the KSM 
Transportation Web page will 
appear. One field, the New Host 
ID will be empty.

— Enter the Host ID of the target 
instrument (step 3 above) into the 
field marked New Host ID.

— Click Submit.

The PC must have an internet connection 
and an available USB port. 
 
Most of the fields have been populated from 
the information in the *.url file. 
 
Be very careful when entering the New Host 
ID. A mistake made in entering the New 
Host ID will result in an invalid license being 
issued. Be sure there is a comma between 
the model number and serial number. There 
should be no spaces in the Host ID.

Step Action Notes
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7 Save License File to USB 
Flash Drive

— The KSM Transportation Web 
page will indicate that a license 
file is available and display two 
links to the license file. 
Right-click on the license file and 
select Save Target As… 

— Save the license file to the root 
level of the USB flash drive, 
keeping the ".lic" file extension.

— Close the Save dialog and exit the 
KSM Transportation Web page.

Either link can be used to either display or 
save the license file. 
 

The license file must be saved to the root 
level of the USB flash drive for it to be 
recognized by the target instrument.

8 Install License File in 
Target Instrument

— With the target instrument 
running, insert the USB flash 
drive into one of the front panel 
USB ports. After a few minutes, 
you should see a message saying 
"Successful License Installation".

— Cycle power on the target 
instrument.

— Once the test set has re-booted, 
the application should be ready to 
use on the target instrument.

The Keysight License Services running on 
the target instrument looks for *.lic files 
whenever it detects a USB device has been 
inserted. If the contents of the *.lic file are 
appropriate for the instrument, the license 
will be installed automatically. 
 
Newly-installed licenses are only recognized 
by the instrument software on power-up.

Step Action Notes
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Windows Configuration
The Windows settings have been optimized for the best measurement 
performance. Any modifications to these settings may degrade test set 
performance and measurement speed. In general, most Windows System 
settings (typically set through the Windows Control Panel) should not be 
modified. Those that can be safely modified are listed below.

Settings that can be changed

You may change the following Windows settings or administrative tasks 
(available from the Windows Control Panel) to select your personal 
preferences. 

To recover from problems caused by changing Windows systems settings, you 
may have to reinstall the Windows system and test set application using the 
Keysight Recovery process.

Before changing any Windows System settings, exit the test set application. 

You may use this feature To do this... 

Configure Microsoft Windows Automatic Updates.

Install and configure an Anti Virus program.

Set up new test set user accounts.

Add the test set to a network.

Install and configure a printer.

Set the time and date.
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Settings that must not be changed

Avoid changing any settings in this section. Changes to the following settings 
may degrade test set performance, screen displays, and measurement speed.

Under Advanced System Settings, System Properties, Advanced, Performance: 
choose either “Let Windows choose what’s best for my computer” or “Adjust for 
best performance”. Leave all other settings unchanged.

You may use this feature To do this... 

Do NOT use this feature To do this... 

Do not change Power Options. 

Do not modify System Properties, Hardware Tab settings.

Do not modify System Properties, Advanced Tab settings (except as 
recommended under “Settings that can be changed” above).

Do not remove installed Fonts.

Do not change the following Display Settings:

— Screen Saver settings (under “Personalization”)
— Screen resolution, 1024 x 768 (under “Adjust Resolution”)
— DPI setting (under “Set custom text size”)

Do not change any settings under “Region and Language” or the instrument 
keyboard and display may not operate properly

Do not delete or modify the “KeysightOnly” or “AgilentOnly” user account.
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In addition, DO NOT:

— Add, delete, or modify hard-disk drive partitions.

— Delete or modify Agilent/Keysight registry entries.

— Change the contents of any directories containing the name “Agilent” or 
“Keysight”.

— Stop these services:

— The MSSQL$CDF service or uninstall the “Microsoft SQL Server 
Desktop Engine”

— The IIS server or tamper with any virtual directories (or their contents) 
that came configured with the test set.

— Uninstall these libraries, interfaces, or programs:

— The Agilent/Keysight I/O Libraries
— The .NET Framework or any Hotfixes or Service Packs for the .NET 

Framework
— The “Microsoft Visual J# .NET Redistributable Package 1.1"
— Programs that begin with “Agilent” or “Keysight”
— The Adobe Acrobat Reader

— Modify

— The Agilent/Keysight I/O Library “GPIB27”, “GPIB28” interfaces 
shown as configured Instrument I/O in the Agilent/Keysight 
Connection Expert or I/O Config.
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Configuring Printers
Printers are configured using the Microsoft Windows Control Panel. It is easily 
accessed from the Windows Start menu or from under the front panel System 
key. This setup process is most easily done using a USB mouse and an external 
keyboard.

When setting up a new printer, you may need to load the printer driver (unless 
you are using a network printer that your IT department has set up to include 
the driver). The manufacturer of the printer supplies the driver software and 
process. That may require that you attach an external USB disk drive. An 
alternative is to connect the test set to the LAN and download the driver from 
the printer manufacturer’s internet site.

Configuring LAN

Hostname

The Computer Name, or hostname, is pre-configured from the factory. It must 
be a unique name so that it does not conflict with other equipment on your 
LAN. The pre-configured Computer Name is K-E6640A-xxxxx, where xxxxx 
represents the last 5 digits of the test set serial number.

To change the Computer Name consult the Microsoft Windows Help and 
Support Center.

IP Address & Gateway

The test set is pre-configured to obtain an IP Address using DHCP. The IP 
Address and Gateway can be changed. Consult the Microsoft Windows Help 
and Support Center to configure the LAN.
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Windows Security
Microsoft recommends the following to ensure the test set Windows operating 
system is protected:

— Use an internet firewall.

— Get the latest critical Windows updates.

— Use up-to-date antivirus software.

To check the status or make changes in the security settings for your test set, 
click Start, Control Panel, and then System and Security. The following 
window appears:

Figure 3-1 System and Security settings

The window may look slightly different on your test set.
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Windows Firewall

Click Windows Firewall in the System and Security window to check the 
firewall status of your test set. The test set is shipped with the Windows 
Firewall enabled.

Figure 3-2 Firewall settings

Windows Firewall exceptions for programs and ports have been added to allow 
proper operation of the test set over a network. Modifying these settings may 
prevent the test set from operating properly.

The window may look slightly different on your test set.
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Automatic updates

Keysight recommends installing Windows updates. This should be enabled in 
Windows security settings. The default test set setting is to automatically 
check for critical Windows Updates and notify you, if the test set has internet 
access.

You can change the configuration of the Microsoft Automatic Updates. Under 
Windows Update in the System and Security window, click Turn automatic 
updating on or off to change settings. If you choose not to hav. e automatic 
updates, you can manually update windows by clicking Check for updates on 
the System and Security window.

Figure 3-3 Automatic update settings

Be aware that downloading and installing Windows Updates can be network and 
CPU usage intensive (impacting the test set performance), and some Windows 
Updates automatically reboot the test set. It is recommended that Windows 
Updates be performed when the test set is not in normal use.
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Virus protection

Under Action Center in the System and Security window, click Review your 
computer’s status and resolve issues to check the status of virus protection 
on your test set. There is no antivirus software included with your test set. 
Antivirus application software has been tested to be compatible with the test 
set. See the section on “3rd party software verified by Keysight” on page 63 
for anti-virus software that has been tested by Keysight.

Figure 3-4 Virus protection settings

Spyware protection

The Review your computer’s status and resolve issues window described 
above also shows the status of spyware protection. There is no anti-spyware 
software installed on the test set. This should not be a problem if you do not 
use the test set for a lot of internet browsing. Having spyware in the test set 
could have an impact on the test set performance.

Having antivirus software installed may have a slight impact on the test set 
performance.
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System Maintenance

Backup

It is recommended that you have a regular backup strategy. Your IT 
department may already have a backup strategy in place which is suitable for 
the test set and its data. Using the Keysight Recovery system in conjunction 
with a regular backup strategy should allow full recovery of the test set data.

The Windows operating system has a Backup utility that you can use to archive 
files and folders in case of a hard disk drive failure. See the Microsoft Windows 
Help and Support Center for more information on this utility. You can also use 
third party backup utilities. However, you must ensure that this third party 
software is compatible with the test set's system software. See “Customer 
Installation of Software” on page 63 for more information.

When performing backups, we recommend that you backup the data to an 
external storage device connected to the network or one of the test set's USB 
connectors. Also, you should perform backups at times when the test set is not 
being used for normal operations as it may impact the test set's overall 
performance.

System restore

Windows contains the capability to restore the system to a previous point in 
time. System Restore is enabled with default settings as provided by Microsoft. 
However, System Restore is not 100% successful. Therefore, it is not the 
recommended method to backup the test set. System Restore has not been 
tested to verify successful restoring.

Disk defragmenting

Over time the hard disk on the test set becomes fragmented. Windows has a 
Disk Defragmenter utility that you can use to defragment the hard disk. See 
the Microsoft Windows Help and Support Center for more information on this 
utility. 

Running Disk Defragmenter should be performed when the measurement 
application is not running. Measurement throughput is significantly impacted 
while disk defragmentation is in process.
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USB Connections
The controller front panel provides two USB 3.0 ports and four USB 2.0 ports to 
which you can connect USB mass storage devices and accessories such as 
printers and keyboards. The test set USB Host support includes the standard 
Microsoft Windows USB class drivers for human interface, mass storage, 
printing, scanning, and imaging devices. A complete up-to-date list of the 
Windows USB class driver support is available on the Microsoft website:

http://www.microsoft.com/whdc/system/bus/usb/USBFAQ_intro.mspx

Figure 3-5 USB ports

The test set USB device driver included in the test set software supports the 
test and measurement industry standard USBTMC-USB488 device class. 

In addition, the Agilent/Keysight IO Libraries that is installed on your test set 
contains USB Host drivers that allow control of other test sets connected to 
the USB bus.

http://www.microsoft.com/whdc/system/bus/usb/USBFAQ_intro.mspx
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Keysight Technologies does not support or warrant correct test set operation if 
additional USB drivers from third parties are installed in the test set. It is 
possible that additional drivers could break the normal USB operation. If USB 
operation is broken, recovery would require reinstalling the test set application 
using the hard drive recovery process. 
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Hard Drive Partitioning and Use
The drive is partitioned into 3 sections: C:, D: and E:

— The C: partition contains the Windows operating system and software 
installed by Keysight. This is an Open System which means you can install 
additional software, and these should be installed on the C: drive. However, 
only a limited set of software applications are tested for use with the 
Keysight measurement software. The installation and/or use of other 
software is not warranted, and could interfere with the operation of the 
measurement software. If test set repair is ever needed, the Keysight 
version of the C: drive is the only part of the test set software that is restored 
by the Keysight Recovery process. You must reload any other software that 
you have added in the test set.

— The D: partition is reserved for data storage. Additionally, this drive is used 
to save customer waveforms and to save custom instrument states. The 
User Accounts that are configured by Keysight have their My Documents 
folder mapped to the D: drive. This is for the convenience of backing-up the 
measurement data. You should always back-up the data on the D: drive to 
an external device. This allows you to restore the data if you ever need to 
replace the hard drive.

— The E: partition is reserved for Keysight’s use. The primary use of the E: 
drive is for housing the Calibration and Alignment data. Do not change or 
overwrite the files on this drive. This could cause your test set to not meet 
specifications, or even to stop functioning correctly. Do not use this drive 
for data storage. It is also recommended that you back up the contents of 
this drive by using the factory calibration data backup utility.
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Hard Drive Recovery Process
The Keysight Recovery System can be used to repair errors on the test set's C: 
drive partition, or to restore the original factory configuration of the system 
software. The Keysight Recovery System is stored in a separate hidden hard 
disk drive partition.

Repairing errors on the hard disk drive may result in loss of data or files. If you 
need more information about the Windows “chkdsk” error repair process, see 
the chkdsk documentation in the Microsoft Windows Help and Support Center.

Restoring the original factory system software does not restore any of the 
following items:

— Windows system configurations that were made after the test set was 
shipped from the factory. For example, Windows and Service Pack updates, 
user accounts, and Windows configuration settings. After an Keysight 
Recovery, these configurations need to be redone.

— Additional software that was installed after the test set was shipped from 
the factory. After an Keysight Recovery, that software needs to be 
re-installed.

— Any data or programs saved on the D: or E: drives.

— Any upgrades that were made to the Keysight measurement application 
software.

Restoring the original factory system software will not synchronize the code in 
the Field Programmable Gate Arrays (FPGAs) on the various hardware 
assemblies. As a result, you may see an error dialog box appear during the final 
boot-up at the end of the recovery process. This typically occurs when there 
are significant differences between the software version installed prior to 
performing the recovery and the version restored by the recovery. In these 
situations, upgrade the software to the latest version.

It is recommended that routine backups of the test set information be 
performed to keep current archives of the test set information. This allows a full 
recovery of the test set information after the test set recovery system 
operations are performed.   See “Backup” on page 81 for more details.

It is recommended that you use a regular back up strategy. Your IT department 
may already have a back up strategy in place which is suitable for the test set and 
its data. See “System Maintenance” on page 81. Using the Keysight 
Recovery System in conjunction with a regular back up strategy should allow you 
to fully recover the test set software and data.
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Table 3-1 Using the test set recovery system

Step Notes

1 Make sure the test set is turned off.

2 Turn on the test set. 
Press the down arrow key to move the 
highlight to Keysight Recovery System, then 
press Enter.

After the Keysight Technologies screen is 
displayed,

This screen is displayed for five seconds.

3 When the Keysight Recovery System has 
booted, follow the on-screen instructions to 
recover the image of the C: drive. 
Press 2, then press Enter to select the 
recovery. 
Press 1, then press Enter to continue. 
Press 1, then press Enter to confirm.

 
 
 
 
 
It may take up to 25 minutes for this process to 
complete.

After exiting the Keysight Recovery System, the test set reboots. If the original factory test set system 
has been restored, the test set re-executes the following process: “Turning on the test set the 
first time” on page 27. 

Additional recovery steps may be required to fully recover the system to a more 
current working state. This could involve restoring your own backups of the test set 
configuration, including re-installing applications, data, and performing system 
customizations.
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Updating the software

The purpose of this update is to ensure that the E6640A’s software, its 
measurement mode applications, and the FPGA content of its PC boards are all 
current and up to date. 

Determining the current software revision

To determine what revision of instrument software is currently installed, press 
System, Show, System using the instrument’s virtual front panel. You can 
access the virtual front panel using a mouse and right-clicking in the 
application window, and selecting Utility, Virtual Front Panel. Once in the 
show system screen, look for the "Instrument S/W Revision" entry (for 
example: "A.13.85"). If the installed revision is the same as the latest revision 
on the web, there is no need to update the instrument software.

Requirements

The following requirements must be met to use this procedure:

— The E6640A must be functioning properly before the update is attempted.

— You must have a USB keyboard and mouse.

— You must be able to log in to the instrument as the administrator.

— You must be able to transfer a large file (~1 GByte) to the E6640A being 
updated.

An update to the instrument software revision does not require a new license key 
for the measurement applications, so long as the applications were licensed 
prior to the update.

This procedure will only update the instrument software that currently resides on 
the C: drive of the instrument. It will not update the version that exists on the 
recovery partition. Because of this, if the recovery process is performed, the 
instrument will revert back to the instrument software revision that was originally 
shipped from the factory.
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File Download

1. Go to http://www.keysight.com/find/e6640a and go to the Technical 
Support section; select the Driver, Firmware & Software tab.

2. Download the executable file by clicking on the file link. Save the file to a 
location of your choice. If you do not have the ability to download files 
directly to the C: drive of the E6640A being updated, store the file on a 
large capacity USB storage device for transfer to the instrument. (The file 
size is ~1 GByte.)

User account and log-in

The default user account is Instrument, which does not have the required 
permissions to install the instrument software updates. For the process 
outlined below, the user must be logged in as Administrator.

The automated instrument software upgrade process has an install wizard 
which removes the old software version and installs new software version 
without manual steps. The removal of the old software version and the 
installation of the new software version completes in approximately 15 
minutes.

1. Connect a USB keyboard and mouse to the E6640A.

2. If the E6640A is not already running, power it up and allow it to boot up 
completely.

3. Shut down the E6640A measurement application if it is running (close all 
TRX windows). 

4. Log out as the default user (Instrument). Click the Start icon at the lower 
left corner of the screen, and select Log Off.

5. Select the Administrator icon on the Windows desktop, to log in as 
follows: 
User Name: administrator 
Password: Keysight4u!

6. If a “Found New Hardware” wizard window pops up, select “No, not at this 
time” to bypass the activity.

http://www.keysight.com/find/e6640a
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Instrument software installation

If you downloaded the instrument software update file to the instrument via 
LAN, access that file from the location that it was stored and proceed to step 1.

If you downloaded the instrument software update file to a USB storage 
device, plug that into one of the USB ports on the front of the instrument. 
Access the file for the removable drive, then proceed to step 1. 

During the installation process, the installer may need to obtain software 
components from external web sites (such as www.microsoft.com). For this 
reason, it is necessary for the instrument to have internet access via the LAN 
during installation of the software.

Table 3-2 Preparing the installation

Step Notes

1 Double click on the installer file, and click 
Yes in the confirmation window that appears.

The file name is in the format: 
XSA_Installer_E.XX.XX.exe

2 A window appears showing the extraction of 
the software installer. Click Install in the 
confirmation window to begin the installation 
process. When the extraction process is 
complete, a software updater display 
appears, showing progress of the software 
removal and installation. 

The update process causes various messages and 
windows to appear and disappear on the screen, 
but the process doesn’t require further 
interaction. Examples of what will be displayed 
are shown below, as a guide to what the process 
looks like while it is running.
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Extraction window:

Software updater window, showing uninstallation progress:

While the old instrument software is being uninstalled, the text “Uninstall in Progress” text rolls across 
the screen, to be replaced finally by “Completed Successfully”. No interaction is required at this point.

Table 3-2 Preparing the installation

Step Notes
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Software updater window, showing installation progress:

During installation, various popup windows may appear temporarily, while required software 
components are downloaded from external sites.

While the new instrument software is being installed, the text “Installation in Progress” text rolls across 
the screen. No interaction is required at this point.  
 
Please be patient: the total installation process can take 30 to 40 minutes.

Table 3-2 Preparing the installation

Step Notes
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During the installation process, an FPGA update warning window (may be displayed, if any FPGA 
updating occurs):

  During FPGA programming, DO NOT power off the E6640A for ANY 
reason! Interrupting the FPGA update process can place the instrument 
in an unusable state, requiring it to be returned to Keysight for repair.

After the installation has completed successfully, a confirmation message is displayed:

3 A reboot is required following the installation 
process.

Reboot the E6640A by clicking Finish in the 
window. Windows will display a “System 
Shutdown” warning window; this is normal.

Table 3-2 Preparing the installation

Step Notes
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It is possible a newer version of the instrument software is available on the web 
at http://www.keysight.com/find/e6640a

4 Clicking the “Finish” button results in a Windows shutdown. 

5 After you power the E6640A back on, it will 
boot up in the default “Instrument” account, 
perform alignments, and finally display the 
measurement screen.  

If the instrument does not reboot, remove the 
USB storage device and cycle power. The boot 
order for the instrument may have been changed 
in the instrument BIOS previously, and the 
instrument may be instructed to boot from USB 
first, and the internal drive second. If this is the 
case, failure to remove the USB device will result 
in an error, as the instrument attempts to boot 
from it.

6 Check for any errors, and verify that the new 
software version is installed. 

In the System menu, press Show > System. 
Look for the line “Instrument S/W Revision”.

Instrument S/W Revision (as it appears in the Traditional interface):

Table 3-2 Preparing the installation

Step Notes

Additional recovery steps may be required to fully recover the system to a more 
current working state. This could involve restoring your own backups of the 
instrument configuration, including re-installing applications, data, and performing 
system customizations.

http://www.keysight.com/find/e6640a_software
http://www.keysight.com/find/e6640a_software
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Configuring recovery prompt timing

You can configure the time at which the test set power-up process waits for the 
selection of the recovery process by performing the following steps: 

Table 3-3 Recovery prompt timing

Step Notes

1 From the Windows Start menu, right-click 
Computer and click Properties.

This opens the System window.

2 Click Advanced System Settings in the 
left pane. 

This opens the System Properties window.

3 In the Startup and Recovery section, click 
Settings. 

This opens the Startup and Recovery window.

4 Under the System Startup section you can 
either clear the Time to display a list of 
operating systems check box,  
or, select the Time to display recovery 
option when needed check box,  
and change the delay setting in seconds. 

 

You must be logged in as an administrator to change these settings. See “User 
Accounts” on page 64 for more information.
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4 OperatingTasks: System-Level Tasks

The following topics can be found in this section:

“TRX Selection” on page 96

“Port Configuration” on page 98

“Switched MIMO” on page 114

“True MIMO” on page 121

“Tx Beam Forming” on page 135

“E6640A Calibration Status” on page 137

“Alignments (MultiTouch Interface)” on page 139

“Alignments (Traditional Interface)” on page 142

“LAN Address Configuration” on page 145

“Managing Licenses” on page 147



 96                                                                                                                                          Getting Started Guide

OperatingTasks: System-Level Tasks
TRX Selection

TRX Selection
On the monitor or remote desktop view of the test set, each TRX is represented 
by a separate XSA window. You can identify which TRX a window controls by 
looking for the identifier (TRX1 through TRX4 for a fully loaded system) at the 
top left corner of the window. The TRXs are placed in numerical order in the 
PXIe chassis, beginning with TRX1 on the left.

Figure 4-1 Identifying application windows for different TRXs

The Traditional interface uses a different color scheme than the MultiTouch 
example illustrated above, but the presentation is otherwise similar.

Open TRX windows are also shown in the Windows taskbar.

Figure 4-2 TRX icons in Windows taskbar

Although the test set as a whole is assigned only one IP address for the entire 
PXIe chassis, the individual TRXs within the chassis can be differentiated in 
network communication with the test set. The means of identifying a TRX 
depends upon the connection method, as outlined below.
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Using HiSLIP

Use hislip0 through hislip3: 

— TRX1:  
TCPIP0::<IP Address>::hislip0::INSTR

— TRX2: 
TCPIP0::<IP Address>::hislip1::INSTR

— TRX3: 
TCPIP0::<IP Address>::hislip2::INSTR 

— TRX4: 
TCPIP0::<IP Address>::hislip3::INSTR 

Using Socket Ports

Use sockets 5025, 5125, 5225, and 5325: 

Using VXI-11/SICL

Use inst0 through inst3: 

— TRX1:  
TCPIP0::<IP Address>::inst0::INSTR

— TRX2: 
TCPIP0::<IP Address>::inst1::INSTR

— TRX3: 
TCPIP0::<IP Address>::inst2::INSTR

— TRX4: 
TCPIP0::<IP Address>::inst3::INSTR

Using Telnet Connection

Use telnet ports 5023, 5123, 5223, 5323: 

— TRX1: 
5023

— TRX2: 
5123

— TRX3: 
5223

— TRX4: 
5323

HiSLIP (High-Speed LAN Instrument Protocol) is the recommended interface for 
connection to the E6640A, because of its superior performance characteristics.
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Port Configuration
Any of the TRXs four RF ports can be configured as an input port (accepting a 
signal to be analyzed) or as an output port (providing an RF stimulus). 

If the test set was purchased with Option 4FD, the TRX model used is M9433A, 
and ports RFIO 1 through RFIO 4 connect to the source and analyzer through a 
splitter/combiner rather than a switch; therefore, they can be used in 
full-duplex mode (that is, with a given port used for both input and output 
simultaneously). These ports can also be configured as input-only, or 
output-only. For more information on this option, see “Option 4FD: Full Duplex 
Port Setup” on page 107 and “Option 4FD: Separate Input and Output Port 
Setup” on page 108.

If the test set was purchased with Option 2FD, the TRX model used is M9432A. 
In this model, only ports RFIO 1 and RFIO 2 connect to the source and alayzer 
through a splitter/combiner (and can therefore be used in full-duplex mode). 
Ports RF3 I|O and RF4 I|O connect to the source and analyzer through a switch 
(each can serve as an input or an output, but can’t do both at once).

The 5G NR test application is currently not supported on the M9432A TRX.
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Full Duplex Port Setup (RFIO 1 and RFIO 2)

Ports RFIO 1 and RFIO 2 on the M9432A TRX (Option 2FD) connect to a 
splitter/combiner, and can therefore be used in full duplex mode. 

Figure 4-3 RFIO 1 on M9432A used in full duplex mode

To use the RFIO 1 port as the input and output, set up the RF Input using this 
menu setting or its equivalent command.

Input/Output > Input > RF Input Port > RFIO 1 
 
Input/Output > RF Input > RF Input Port > RFIO 1

Command: 
:FEED:RF:PORT RFIO1

Then set up the RF Output using this menu setting or its equivalent command: 

Input/Output > RF Source > RF Output Port RFIO1 
 
Input/Output > More > RF Output & Test Set Config > RF Output Port >  
RFIO 1 

Command: 
:FEED:RF:PORT:OUTP RFIO1

The menu path for the MultiTouch interface is listed first, followed by the path 
for the Traditional interface in italics.
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Figure 4-4 RFIO 2 on M9432A used in full duplex mode

To use the RFIO 2 port as the input and output, set up the RF Input using this 
menu setting or its equivalent command: 

Input/Output > Input > RF Input Port > RFIO 2 
 
Input/Output > RF Input > RF Input Port > RFIO 2

Command: 
:FEED:RF:PORT RFIO2

Then set up the RF Output using this menu setting or its equivalent command: 

Input/Output > RF Source > RF Output Port RFIO 2 
 
Input/Output > More > RF Output & Test Set Config > RF Output Port >  
RFIO 2

Command: 
:FEED:RF:PORT:OUTP RFIO2

The menu path for the MultiTouch interface is listed first, followed by the path 
for the Traditional interface in italics.
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Separate Input and Output Port Setup (RF3 I|O and RF4 I|O)

Ports RF3 I|O and RF4 I|O on the M9432A TRX (Option 2FD) connect to a switch 
rather than a splitter/combiner, which means that one of these ports must be 
used as either an input or an output, not both, at any given time.

Because there is less RF path loss when a switch is used, these ports are 
preferred in situations where it is important to maximize RF power to the 
analyzer or from the source.  

Figure 4-5 RF3 I|O on M9432A used as input, RF4 I|O as output

To define RF3 I|O as an input and RF4 I|O as an output, follow this four-step 
process. 

(1) Define RF3 I|O as an input, using this menu setting or its equivalent 
command: 

Input/Output > Input > Half Duplex Input Port > RF3 I|O 
 
Input/Output > More > RF Output & Test Set Config > Half Duplex Config >  
RF Input Port > RF3 I|O

Command: 
:HDUPlex:PORT:INPut RFIO3

The menu path for the MultiTouch interface is listed first, followed by the path 
for the Traditional interface in italics.
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(2) Define RF4 I|O as an output, using this menu setting or its equivalent 
command: 

Input/Output > RF Source > Half Duplex Output Port > RF4 I|O 
 
Input/Output > More > RF Output & Test Set Config > Half Duplex Config > 
RF Output Port > RF4 I|O

Command: 
[:SENSe]:HDUPlex:PORT:OUTPut RFIO4

(3) Set up the RF Input using this menu setting or its equivalent command: 

Input/Output > Input >  RF Input Port > RF Input 
 
Input/Output > RF Input >  RF Input Port > RF Input

Command: 
:FEED:RF:PORT RFIN

(4) Set up the RF Output using this menu setting or its equivalent command: 

Input/Output > Source > RF Output Port > RF Output 
 
Input/Output > More > RF Output & Test Set Config > RF Output Port >  
RF Output

Command: 
:FEED:RF:PORT:OUTP RFO



Getting Started Guide                                                                                                                                          103

OperatingTasks: System-Level Tasks
Port Configuration

Figure 4-6 RF3 I|O on M9432A used as output, RF4 I|O as input

To define RF4 I|O as an input and RF3 I|O as an output, follow this four-step 
process. 

(1) Define RF4 I|O as an input, using this menu setting or its equivalent 
command:

Input/Output > Input > Half Duplex Input Port > RF4 I|O 
 
Input/Output > More > RF Output & Test Set Config > Half Duplex Config >  
RF Input Port > RF4 I|O

Command: 
:HDUPlex:PORT:INPut RFIO4

(2) Define RF3 I|O as an output, using this menu setting or its equivalent 
command: 

Input/Output > RF Source > Half Duplex Output Port > RF3 I|O 
 
Input/Output > More > RF Output & Test Set Config > Half Duplex Config > 
RF Output Port > RF3 I|O

Command: 
[:SENSe]:HDUPlex:PORT:OUTPut RFIO3

The menu path for the MultiTouch interface is listed first, followed by the path 
for the Traditional interface in italics.
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(3) Set up the RF Input using this menu setting or its equivalent command: 

Input/Output > Input >  RF Input Port > RF Input 
 
Input/Output > RF Input >  RF Input Port > RF Input

Command: 
:FEED:RF:PORT RFIN

(4) Set up the RF Output using this menu setting or its equivalent command: 

Input/Output > Source > RF Output Port > RF Output 
 
Input/Output > More > RF Output & Test Set Config > RF Output Port >  
RF Output

Command: 
:FEED:RF:PORT:OUTP RFO
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Separate Input and Output Port Setup (RFIO 1 and RFIO 2)

Although Ports RFIO 1 and RFIO 2 on the M9432A TRX (Option 2FD) are 
designed to operate as full-duplex ports, they can function as separate inputs 
and outputs. 

Figure 4-7 RFIO 1 on M9432A used as input, RFIO 2 as output

To use the RFIO 1 port as the input and the RFIO 2 port as the output, set up 
the RF Input using this menu setting or its equivalent command: 

Input/Output > Input > RF Input Port > RFIO 1 
 
Input/Output > RF Input > RF Input Port > RFIO 1

Command: 
:FEED:RF:PORT RFIO1

Then set up the RF Output using this menu setting or its equivalent command: 

Input/Output > RF Source > RF Output Port RFIO 2 
 
Input/Output > More > RF Output & Test Set Config > RF Output Port >  
RFIO 2 

Command: 
:FEED:RF:PORT:OUTP RFIO2

The menu path for the MultiTouch interface is listed first, followed by the path 
for the Traditional interface in italics.
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Figure 4-8 RFIO 2 on M9432A used as input, RFIO 1 as output

To use the RFIO 1 port as the input and the RFIO 2 port as the output, set up 
the RF Input using this menu setting or its equivalent command: 

Input/Output > Input > RF Input Port > RFIO 2 
 
Input/Output > RF Input > RF Input Port > RFIO 2

Command: 
:FEED:RF:PORT RFIO2

Then set up the RF Output using this menu setting or its equivalent command: 

Input/Output > RF Source > RF Output Port RFIO 1 
 
Input/Output > More > RF Output & Test Set Config > RF Output Port >  
RFIO 1 

Command: 
:FEED:RF:PORT:OUTP RFIO1

The menu path for the MultiTouch interface is listed first, followed by the path 
for the Traditional interface in italics.
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Option 4FD: Full Duplex Port Setup

If the test set was purchased with Option 4FD, the M9433A TRX is used. Each 
of the IO ports connects to a splitter/combiner rather than a switch, and it can 
be used in full duplex mode, as a simultaneous input and output. In the 
example illustrated below, the RFIO 2 port is used in this way. (Other ports 
could be selected simply by substituting different port names in the 
instructions provided below.)

Figure 4-9 RFIO 2 on M9433A used in full duplex mode

To use the RFIO 2 port as the input and output, set up the RF Input using this 
menu setting or its equivalent command: 

Input/Output > Input > RF Input Port > RFIO 2 
 
Input/Output > RF Input > RF Input Port > RFIO 2

Command: 
:FEED:RF:PORT RFIO2

Then set up the RF Output using this menu setting or its equivalent command: 

Input/Output > RF Source > RF Output Port RFIO 2 
 
Input/Output > More > RF Output & Test Set Config > RF Output Port >  
RFIO 2 

Command: 
:FEED:RF:PORT:OUTP RFIO2

The menu path for the MultiTouch interface is listed first, followed by the path 
for the Traditional interface in italics.
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Option 4FD: Separate Input and Output Port Setup

Although, with Option 4FD, all of the RFIO ports are designed to operate as 
full-duplex ports, they can function as separate inputs and outputs. In this 
example, the RFIO 2 port is used as an input, and the RFIO 3 port as an output. 
(Other port combinations could be selected simply by substituting different 
port names in the instructions provided below.)

Figure 4-10 RFIO 2 on M9433A used as input, RFIO 3 as output

To use the RFIO 2 port as the input and the RFIO 3 port as the output, set up 
the RF Input using this menu setting or its equivalent command: 

Input/Output > Input > RF Input Port > RFIO 2 
 
Input/Output > RF Input > RF Input Port > RFIO 2

Command: 
:FEED:RF:PORT RFIO2

Then set up RFIO 3 as the RF Output, using this menu setting or its equivalent 
command: 

Input/Output > RF Source > RF Output Port RFIO 3 
 
Input/Output > More > RF Output & Test Set Config > RF Output Port >  
RFIO 3 

Command: 
:FEED:RF:PORT:OUTP RFIO3

The menu path for the MultiTouch interface is listed first, followed by the path 
for the Traditional interface in italics.
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Millimeter-Wave Accessory Instruments

For testing at higher frequencies than the EXM itself can generate, two other 
instruments are commonly used with the EXM: the M1740A mmWave 
Transceiver (usually called the Remote Radio Head or RRH) and the E7770A 
Common Interface Unit (usually called the CIU).                      

Figure 4-11 EXM used with M1740A (left) and E7770A (top)
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As illustrated below, the CIU is able to upconvert the RF output of the EXM to 
the 6-12 GHz range (the lower portion of the picture), and apply this signal to 
the DUT. On the same path, it also can accept a return signal from the DUT, 
downconvert it to the range of the EXM, and return it to an input port on the 
EXM.

For mmWave testing (the upper portion of the picture), the RF output of the 
EXM can pass through the CIU (bypassing the upconverter) to the M1740A 
remote radio head, where it is upconverted to a mmWave signal which is 
transmitted wirelessly to the DUT. The returned mmWave signal is received by 
the M1740A, downconverted, and passed back through the CIU to the EXM RF 
input. The CIU also supplies the combined LO, DC Power, and Control inputs 
which the M1740A requires. The LO/Ctrl/Pwr output of the CIU is the only 
essential connection between the CIU and M1740A, because the RF input and 
output from the EXM can be cabled directly between the EXM and the 
M1740A, rather than passing through the CIU as in this illustration.

Figure 4-12 Functional block diagrams of M1740A and E7770A
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In the test setup illustrated below, the EXM is used to drive mmWave testing of 
the DUT over a wireless interface (typically using horn antennas within a test 
chamber). The CIU provides the combined LO, Power, and Control inputs 
needed by the M1740As. In this case the inputs and outputs from the EXM are 
applied directly to the M1740As, instead of being passed through the CIU.

Figure 4-13 EXM, CIU, and four M1740As used for mmWave testing
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The test setup illustrated below expands on the previous example, by adding 
6-12 GHz testing of the DUTs over a wired interface. A second CIU is used for 
upconversion of the EXM output to the 6-12 GHz range (and downconversion 
of the signal returned by the DUT). The first CIU is not used for this, because its 
LO resources are providing the combined LO, Power, and Control inputs 
needed by the M1740As, and are therefore not available to support 
upconversion and downconversion.

Figure 4-14 EXM, 2 CIUs, and four M1740As; mmWave testing and 6-12 GHz testing
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The test setup illustrated is used for WLAN testing, which requires an input to 
the DUT in the 7 GHz range, which is slightly above the frequency range of the 
EXM. An output signal from the EXM is upconverted by the CIU and furnished 
to the DUT. The returned signal from the DUT, being below 6 GHz, is returned 
directly to the EXM instead of being passed through the CIU for 
downconversion.

Figure 4-15 CIU used for WLAN testing 
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Switched MIMO
For WLAN modulation accuracy measurements, a form of MIMO measurement 
can be made with a single TRX, using a time-division multiplexing process. The 
same source/analyzer pair within the TRX switches between the antenna ports 
of the Device Under Test.

In contrast to true MIMO functionality, which is available in WLAN mode but 
not in Sequence Analyzer mode, the switched MIMO feature is a WLAN 
measurement which is available only in Sequence Analyzer mode.

Constraints on Radio Standards

Only the 802.11n and 802.11ac radio standards for WLAN support MIMO.  

MIMO Port Configuration

For 2x2 MIMO, the RFIO 1 port (a full-duplex port) captures the data stream 
from the first antenna port of the DUT. The other full-duplex port, RFIO 2, 
captures the data stream from the second antenna port of the DUT. 

Figure 4-16 2X2 switched MIMO connections
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For 3x3 MIMO, the RFIO 1 port (a full-duplex port) captures the data stream 
from the first antenna port of the DUT. The other full-duplex port, RFIO 2, 
captures the data stream from the second antenna port of the DUT. One of the 
half-duplex ports, RF3 I|O or RF4 I|O, captures the data stream from the third 
antenna port of the DUT.

Figure 4-17 3X3 switched MIMO connections

Source Sync Control

Switched MIMO is a measurement process only; it is not necessary to use 
Source Sync Control (required for true MIMO) in the case of switched MIMO.

RF Input Port Mode

The RF Input Port Mode must be set to List, so that the sequence can change 
the input port path from one acquisition to the next. In the Meas Setup > 
Advanced > RF Input Port Mode menu, select List. 

The equivalent menu path in the Traditional interface is: Meas Setup > RF 
Input Port Mode.

The equivalent SCPI command is: 
[:SENSe]:LSEQuencer:PORT:INPut:MODE LIST
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Half Duplex RF Input

In the case of 3x3 switched MIMO, one of the half-duplex ports (RF3 I|O or RF4 
I|O) must be designated as an RF input port for the third input. In the 
Input/Output > Input > Half Duplex Input Port menu, select RFIO3 or RFIO4, 
so that the RF3 I|O port or the RF4 I|O port is defined as the input port. 

The equivalent menu path for the Traditional interface is: 
Input/Output > RF Output & Test Set Config > Half Duplex Config > RF Input 
Port

The equivalent SCPI command is: 
[:SENSe]:HDUPlex:PORT:INPut RFIO3|RFIO4

Acquisition Triggers

Each of the acquisitions which make up a sequence used for switched MIMO 
testing needs to have the same trigger settings as the others.

Acquisition Integration

For 2x2 switched MIMO in Sequence Analyzer mode, two separate acquisitions 
are used for the two separate ports, and must be integrated. Set up acquisition 
integration as follows: in the Meas Setup > Settings > Integration Type menu, 
select Primary for the first acquisition and Switch MIMO for the second. The 
equivalent SCPI commands are: 
[:SENSe]:LSEQuencer:ACQuire{1:512}:SETup:INTegration PRIMary  
[:SENSe]:LSEQuencer:ACQuire{1:512}:SETup:INTegration SMIMo

The equivalent menu path for the Traditional interface is: 
Meas Setup > Acquisition Setup > Acquisition Integration

For 3x3 switched MIMO in Sequence Analyzer mode, three separate 
acquisitions are used for the three separate ports, and must be integrated. Set 
up acquisition integration as follows: in the Meas Setup > Settings > 
Integration Type menu, select Primary for the first acquisition and Switch 
MIMO for the second and third. The equivalent SCPI commands are: 
[:SENSe]:LSEQuencer:ACQuire{1:512}:SETup:INTegration PRIMary  
[:SENSe]:LSEQuencer:ACQuire{1:512}:SETup:INTegration SMIMo 
[:SENSe]:LSEQuencer:ACQuire{1:512}:SETup:INTegration SMIMo 

The equivalent menu path for the Traditional interface is: 
Meas Setup > Acquisition Setup > Acquisition Integration

The integration parameter can also be set within the complex 
command which is used to set the Acquisition RF Input Port (see 
“Acquisition RF Input Port” on page 117); the integration 
parameter is the one which comes immediately before the Acquisition 
RF Input Port parameter.
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Acquisition RF Input Port

An RF input path must be selected for each acquisition. In the Meas Setup > 
Settings > RF Input Port menu, select RFIO1, RFIO2, or RF Input, as needed 
for each acquisition. 

The equivalent menu path for the Traditional interface is: 
Meas Setup > Acquisition Setup > Acquisition RF Input Port

The RF Input selection, which is used for the third port in 3x3 switched MIMO, 
means that whichever of the half-duplex ports (RF3 I|O or RF4 I|O) has been 
designated as the RF input is used (see “Half Duplex RF Input” on page 116). 
In SCPI, the acquisition RF input port is controlled by the last parameter in the 
complex command which configures the acquisition (the values for the relevant 
parameter are italicized here): 
[:SENSe]:LSEQuencer:ACQuire[1]|2|...|4..512:SETup  
NONE | GSM | EDGE | WCDMA | CDMA2K | CDMA1XEV | LTE | LTETDD | 
TDSCDMA | BTooth | WLAN,  
NONE | PGSM | EGSM | RGSM | DCS1800 | PCS1900 | TGSM810 | GSM450 | 
GSM480 | GSM850 | GSM700 | BANDI | BANDII | BANDIII | BANDIV | 
BANDV | BANDVI | BANDVII | BANDVIII | BANDIX | BANDX | BANDXI | 
BANDXII | BANDXIII | BANDXIV | USCELL | USPCS | JAPAN | KOREAN | 
NMT | IMT2K | UPPER | SECOND | PAMR400 | PAMR800 | IMTEXT | 
PCS1DOT9G | AWS | US2DOT5G | PUBLIC | LOWER | BAND1 | BAND2 | BAND3 
| BAND4 | BAND5 | BAND6 | BAND7 | BAND8 | BAND9 | BAND10 | BAND11 | 
BAND12 | BAND13 | BAND14 | BAND17 | BAND18 | BAND19 | BAND20 | 
BAND21 | BAND24 | BAND25 | BAND26 | BAND27 | BAND28 | BAND31 | 
BAND33 | BAND34 | BAND35 | BAND36 | BAND37 | BAND38 | BAND39 | 
BAND40 | BAND41 | BAND42 | BAND43 | BAND44 | BANDA | BANDB | BANDC 
| BANDD | BANDE | BANDF,  
BTS | MS, 
<real>, <integer>, <ampl>, 
LOW | ZERO | HIGH, 
<time>, <time>,  
IMMediate | VIDeo | Video2 | INTernal | EXT1 | EXT2, 
<amptd>, <time>, 
NONE | INT/, 
<relative ampl>, 
OFF | RFIO0 | RFIO1 | RFIO2 | RFIO3 | RFIO4 | RFIO5 | RFIO6 | 
RFIO7,  
ON | OFF,  
NORMal | PRIMary | LOWer | UPPer | RANGe | SMIMo,  
RFIO1 | RFIO2 | RFIN | RFIO3 | RFIO4 

In the Acquisition RF Input Port parameter (italicized above), the 
values RFIO3 and RFIO4 apply only if the test set has Option 4FD. The 
parameter immediately preceding that one is the Acquisition 
Integration parameter, and can be set to PRIMary or SMIMo as 
needed (see “Acquisition Integration” on page 116). 
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Switched MIMO Modulation Accuracy measurement SCPI commands

The following commands are used to set up the MIMO Modulation Accuracy 
(“EVM MIMO”) measurement. 

Command Description Notes

:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit: 
FERRor <real>

Freq Error Sets a frequency 
error limit

:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit: 
CLKerror <real>

Clock Error Sets a clock error 
limit

:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit: 
CFLeakage <rel_ampl>

Center Freq Leakage Sets Center Freq 
Leakage limit

:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit: 
CFLeakage <rel_ampl>

BPSK–1/2 RMS EVM Sets  BPSK coding 
rate 1/2 RMS EVM 
limit

:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit:RMS: 
BPSK:R1B2 <rel_ampl>

QPSK–1/2 RMS EVM Sets  QPSK coding 
rate 1/2 RMS EVM 
limit

:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit:RMS: 
QPSK:R1B2 <rel_ampl>

QPSK–3/4 RMS EVM  Sets  QPSK coding 
rate 3/4 RMS EVM 
limit

:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit:RMS: 
QPSK:R3B4 <rel_ampl>

16QAM–1/2 RMS 
EVM

Sets 16QAM coding 
rate 1/2 RMS EVM 
limit

:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit:RMS: 
QA16:R1B2 <rel_ampl>

16QAM–3/4 RMS 
EVM

Sets 16QAM coding 
rate 3/4 RMS EVM 
limit

:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit:RMS: 
QA16:R3B4 <rel_ampl>

64QAM–2/3 RMS 
EVM

Sets 64QAM coding 
rate 2/3 RMS EVM 
limit

:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit:RMS: 
QA64:R2B3 <rel_ampl>

64QAM–3/4 RMS 
EVM

Sets 64QAM coding 
rate 3/4 RMS EVM 
limit

:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit:RMS: 
QA64:R5B6 <rel_ampl>

64QAM–5/6 RMS 
EVM

Sets 64QAM coding 
rate 5/6 RMS EVM 
limit

:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit:RMS: 
QA256:R3B4 <rel_ampl>

256QAM–3/4 RMS 
EVM

 Sets  256QAM 
coding rate 3/4 
RMS EVM limit

:CALCulate:LSEQuencer:WLAN:EVMMimo:LIMit:RMS: 
QA256:R5B6 <rel_ampl>

256QAM–5/6 RMS 
EVM

Sets  256QAM 
coding rate 5/6 
RMS EVM limit
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:CALCulate:LSEQuencer:WLAN:EVMMimo:EQUalizer: 
TMODe SEQuence|SDATa

Equalizer Training Specifies how the 
equalizer is 
initialized or 
trained.

:CALCulate:LSEQuencer:WLAN:EVMMimo:PILot:TRACk:AMPLi
tude OFF|ON|0|1

Track Amplitude Sspecifies whether 
analyzer tracks 
amplitude changes 
in the pilot 
subcarriers.

:CALCulate:LSEQuencer:WLAN:EVMMimo:PILot:TRACk: 
PHASe OFF|ON|0|1

Track Phase Specifies whether 
analyzer tracks 
phase changes in 
the pilot 
subcarriers.

:CALCulate:LSEQuencer:WLAN:EVMMimo:PILot:TRACk:TIMin
g OFF|ON|0|1

Track Timing Specifies whether 
analyzer tracks 
timing changes in 
the pilot 
subcarriers.

:CALCulate:LSEQuencer:WLAN:EVMMimo:PILot:TRACk:MODE 
POSTeq|PREeq

Pilot Tracking Mode Specifies the Pilot 
Tracking Mode. The 
valid values are 
Post EQ and Pre EQ. 

[:SENSe]:LSEQuencer:WLAN:EVMMimo: 
MTYPe DMAP|FOURier

Matrix Type Specifies MIMO 
matrix type.

Command Description Notes
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Switched MIMO Results

The results available for a WLAN MIMO Modulation Accuracy measurement are 
as follows (the results for Stream 3 are returned as -1.0 (not tested) in the case 
of 2x2 MIMO):

Index Result Parameter

0 Overall Pass/Fail Result (0 = Pass, 1 = Fail, -1 = Not tested)

1 Stream 1 RMS EVM pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)

2 Stream 1 RMS EVM (dB)

3 Stream 1 Peak EVM (dB)

4 Stream 1 Pilot EVM (dB)

5 Stream 1 Data EVM (dB)

6 Stream 1 Chips Peak EVM (%)

7-18 7-12: Stream 2 (as in Index 1-6 above). 13-18: Stream 3 (as in Index 1-6 above)

19-24 Reserved

25 Channel 1 RMS EVM pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)

26 Channel 1 Frequency Error pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)

27 Channel 1 Symbol Clock Error pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)

28 Channel 1 IQ Offset pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)

29 Channel 1 RMS EVM (dB)

30 Channel 1 Peak EVM (dB)

31 Channel 1 Pilot EVM (dB)

32 Channel 1 Data EVM (dB)

33 Channel 1 Frequency Error (Hz)

34 Channel 1 Symbol Clock Error (ppm)

35 Channel 1 IQ Gain Imblance (dB)

36 Channel 1 IQ Offset (dB)

37 Channel 1 IQ Quadrature Error (deg)

38 Channel 1 IQ Timing Skew (pps)

39 Channel 1 Cross Power (dB)

40 Channel 1 Sync Corr

41-72 41-56: Channel 2 (as in Index 25-40 above). 57-72: Channel 3 (as in Index 25-40 above)

73-88 Reserved
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True MIMO
In WLAN mode, True MIMO (simultaneous rather than switched MIMO) is 
supported for the MIMO Modulation Analysis measurement. (This functionality 
is not available in Sequence Analyzer mode.) Setting up this type of 
measurement requires configuration of two separate TRXs.

For MIMO Modulation Analysis, two or more measurement data streams are 
captured simultaneously, by two or more separate TRXs in the EXM test set. In 
the EXM, the TRXs share a common frequency reference. They also share a 
common IP address, but have separate socket numbers. In MIMO testing, a 
single TRX is designated the primary, and it controls the other TRX or TRXs 
used.

TRX Configurations

Here is an example of 2x2 MIMO:

Figure 4-18 2X2 true MIMO connections

In the example setup shown here, TRX 1 runs the MIMO Modulation Analysis 
measurement, and is also configured to control TRX 2, which collects the 
second data stream. The primary TRX controls the measurement settings for 
the secondary TRX, and also processes the measurement data collected by the 
secondary. (The display window for the secondary will display a mostly-blank 
screen, with a message indicating that it is in use by the primary.)
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Here is an example of 3x3 MIMO:

Figure 4-19 3X3 true MIMO connections

In the example setup shown here, TRX 1 runs the MIMO Modulation Analysis 
measurement, and is also configured to control TRX 2 and 3, which collect the 
second and third data streams. 
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Here is an example of 4x4 MIMO:

Figure 4-20 4X4 true MIMO connections

In the example setup shown here, TRX 1 runs the MIMO Modulation Analysis 
measurement, and is also configured to control TRX 2 to 4, which collect the 
second, third, and fourth data streams. 
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Source Settings for MIMO

Unlike measurement settings, which are made only to the primary TRX and 
applied to the others, source settings can be made separately for each TRX. 
However, it is possible to make certain source settings to other TRXs by 
making those settings on the primary TRX. Also, when the measurement is run, 
the primary TRX communicates with the other TRXs to ensure that they begin 
playing ARB files simultaneously.

To run the sources synchronously:

1. If there are any source settings which you don’t plan to make by way of the 
primary TRX, begin by making them individually on each TRX which will be 
used in the MIMO test. Then open the primary TRX.

2. For the MultiTouch Interface: in the Input/Ouput > RF Source > Source 
Sync menu, click Sync Config and set the source synchronization type. 
(The menu path for the Traditional interface is Source > Source Sync 
Control > Sync Config.)

— For 2x2 MIMO, select 2x2. Do this for both TRXs. The equivalent 
SCPI command is: 
:SOURce:SYNC:CONFig TWO

— For 3x3 MIMO, select 3x3. Do this for all three TRXs. The equivalent 
SCPI command is: 
:SOURce:SYNC:CONFig THRee

— For 4x4 MIMO, select 4x4. Do this for all four TRXs. The equivalent 
SCPI command is: 
:SOURce:SYNC:CONFig FOUR

— For 2x2 + 2x2 MIMO, select 2x2+2x2. Do this for all four TRXs. The 
equivalent SCPI command is: 
:SOURce:SYNC:CONFig DTWO

— For 1x1 + 1x1 MIMO, select 1x1+1x1. Do this for all four TRXs. The 
equivalent SCPI command is: 
:SOURce:SYNC:CONFig DONE

3. In the window for the primary TRX, go to the Input/Output > RF Source > 
Source Sync > Sync Settings window and set Sync Settings Switch to the 
On state. (The menu path for the Traditional interface is Source > Source 
Sync Control > Sync Settings Setup > Sync Settings.) With this feature 
enabled, certain settings for the primary TRX source (frequency, 
amplitude, waveform, trigger source, trigger type, and RF output) are also 
applied to the other TRX sources. The equivalent SCPI command is: 
:SOURce:SYNC:SETT:ENAB ON

4. For 1x1 + 1x1 MIMO or 2x2 + 2x2 MIMO, go to the Input/Output > RF 
Source > Source Sync > Sync Settings window and set Segment 2 Setup 
> Sync Segment 2 to the On state. (The menu path for the Traditional 
interface is Source > Source Sync Control > Sync Settings Setup > 
Segment 2 Setup.) With this feature enabled, certain non-frequency 
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settings for the primary TRX source (amplitude, waveform, trigger source, 
trigger type, and RF output) are also applied to the second of two “2x2 + 
2x2” or “1x1 + 1x1” pairs of TRXs. The equivalent SCPI command is: 
:SOUR:SYNC:SETT:SEGM2:ENAB ON

5. For 1x1 + 1x1 MIMO or 2x2 + 2x2 MIMO, go to the Input/Output > RF 
Source > Source Sync > Sync Settings window and enter a value for 
Segment 2 Setup > Segment 2 Frequency. (The menu path for the 
Traditional interface is Source > Source Sync Control > Sync Settings 
Setup > Segment 2 Setup.) This makes it possible to apply a frequency 
setting to the second of two “2x2 + 2x2” or “1x1 + 1x1” pairs of TRXs. This 
is necessary if the desired frequency is anything other than the default 
value of 1 GHz. An example of the equivalent SCPI command is: 
:SOUR:SYNC:SETT:SEGM2:FREQ 2.00 GHz

6. In the window for the primary TRX, activate synchronization: go to the 
Input/Output > RF Source > Source Sync menu and click Sync Start. (The 
menu path for the Traditional interface is Source > Source Sync Control.)  
At this point, the other TRX sources are synchronized to the primary and 
will play their arb files simultaneously with it. The equivalent SCPI 
command is: 
:SOUR:SYNC:STARt 
You can stop synchronization by clicking Sync Stop in the menus 
described above. The equivalent SCPI command is: 
:SOURce:SYNC:STOP

When Sync Settings is enabled, the naming of waveform files used 
by the sources must be coordinated; see “Constraints on 
Waveform File Names” on page 126.
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Constraints on Waveform File Names

When Sync Settings is enabled, as described in the previous procedure, it is 
necessary to follow a convention for naming the waveform files used by the 
TRXs, so that the file associated with each TRX is distinguished by a 
TRX-specific suffix. The table below lists the suffixes for each MIMO 
configuration. Note that the convention for the 4X4 configuration is not the 
same as the convention for a pair of 2X2 configurations. 

Constraints on TRX Selection

Not every TRX can be designated the primary for purposes of MIMO testing. 
The permitted configurations are: 

MIMO Configuration TRX Numbers Equivalent Waveform File Names
(“.xxx” can be .wfm, .bin, or .seq)

2x2 TRX 1 or TRX3 
TRX 2 or TRX4

<name>0.xxx 
<name>1.xxx

3x3 TRX 1 
TRX 2 
TRX 3

<name>0.xxx 
<name>1.xxx 
<name>2.xxx

4x4 TRX 1 
TRX 2 
TRX 3 
TRX 4

<name>0.xxx 
<name>1.xxx 
<name>2.xxx 
<name>3.xxx

2x2 + 2x2 TRX 1 
TRX 2 
TRX 3 
TRX 4

<name>0_0.xxx 
<name>0_1.xxx 
<name>1_0.xxx 
<name>1_1.xxx

1x1 + 1x1 TRX1 or TRX3 
TRX2 or TRX4

<name>0_0.xxx  
<name>1_0.xxx

MIMO Configuration Primary TRX Secondary TRXs

2x2 TRX 1 TRX 2, Socket 5125

2x2 (alternative setup) TRX 3 TRX 4, Socket 5325

3x3 TRX 1 TRX 2, Socket 5125 
TRX 3, Socket 5225

4x4 TRX 1 TRX 2, Socket 5125 
TRX 3, Socket 5225 
TRX 4, Socket 5325
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Constraints on Radio Standards

Only certain radio standards support MIMO. Under Mode Setup > Radio Std, 
select 802.11n or 802.11ac. 

MIMO Type

For the MIMO Modulation Analysis measurement, go to the Meas Setup > 
MIMO Type menu and select 2x2, 3x3, or 4x4.This setting determines whether 
the display shows two, three, or four constellation diagrams for the 
measurement.) The equivalent SCPI command is: 
[:SENSe]:EVMMimo:TYPe M2M2|M3M3|M4M4

Remote Analyzer Configuration (MultiTouch Interface)

This feature is used to coordinate TRXs within the test set; it is named this way 
because its original purpose was to coordinate the test set with external 
equipment.

1. From the primary TRX window (TRX 1 in this example), in WLAN mode, 
MIMO Modulation Analysis measurement, select Meas Setup > Global > 
Remote Analyzer Config.

2. A table is displayed which includes any TRX which you have previously 
used (unless you have deleted it) and any added by means of the Add 
Analyzer key. However, the list may be blank, or may not include the 
desired TRX.

3. To add a TRX to the list, click Add Analyzer. 

4. Click IP and use the popup window to enter an IP address for the test set. 
In this example, the test set’s localhost address is used (for the EXM test 
set, the localhost address has a fixed value of 127.0.0.1). 

5. Click SCPI Socket Port and use the popup window to enter the socket 
number of the secondary TRX. In this example socket number 5125 (TRX 
2) is used. 

6. Highlight the secondary TRX in the table and press Verify Highlighted 
Analyzer. (A message confirming that the analyzer has been verified 
successfully will appear, if everything is configured correctly.) 

7. Highlight the secondary TRX in the table and press Select Highlighted 
Analyzer). The secondary TRX is now being run from the present TRX. The 
window for the secondary TRX displays a message stating that a remote 
computer or instrument is in control of the local hardware. If you need to 
release it from control, go to the primary TRX and select Release 

The MIMO configuration that is set up here needs to match the 
MIMO Type selection, as described above. Error messages will be 
displayed until the two are in agreement. 
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Highlighted Analyzer from the Remote Analyzer Config window, or send 
to the primary the equivalent SCPI command: 
:SYST:COMM:ANAL:REL 

8. The equivalent SCPI command for the steps described above is as follows 
(modify the address string "127.0.0.1:5125" as needed): 
:SYST:COMM:ANAL:SEL "127.0.0.1:5125"

Figure 4-21 IP and socket port addresses (MultiTouch interface)

The command equivalent for 3x3 MIMO would be: 
:SYST:COMM:ANAL:SEL "127.0.0.1:5125" 
:SYST:COMM:ANAL:SEL "127.0.0.1:5225" 
 
The command equivalent for 4x4 MIMO would be: 
:SYST:COMM:ANAL:SEL "127.0.0.1:5125" 
:SYST:COMM:ANAL:SEL "127.0.0.1:5225" 
:SYST:COMM:ANAL:SEL "127.0.0.1:5325"

The procedure given above is for 2x2 MIMO; the process is the same for 3x3 or 
4x4 MIMO, except that more TRXs are added. 
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Remote Analyzer Configuration (Traditional Interface)

1. From the primary TRX window (TRX 1 in this example), select Mode Setup 
> Global Settings > Remote Analyzer Config.

2. A list is displayed which includes any TRX which you have previously used 
(unless you have deleted it) and any added while in the Add Analyzer to 
List menu. However, the list may be blank, or may not include the desired 
TRX.

3. To add a TRX to the list, press Add Analyzer to List. 

4. Click IP Address, use the numeric keys to enter an IP address for the test 
set, and press Enter. In this example, the test set’s localhost address is 
used (for the EXM test set, the localhost address has a fixed value of 
127.0.0.1). 

5. Click SCPI Socket Port, use the numeric keys to enter the socket number 
of the secondary TRX, and press Enter. In this example socket number 
5125 (TRX 2) is used. 

6. Press Add. The secondary TRX is now displayed in the list. 

7. Select the desired TRX from the displayed list (use the up and down arrow 
keys to move the highlighted selection to the desired TRX and then press 
Select Highlighted Analyzer).

8. The secondary TRX is now being run from the present TRX. The window for 
the secondary TRX displays a “This instrument is in use...” message. If you 
need to release it from control, go to the primary TRX and select Remote 
Analyzer Config > Release Current Analyzer, or send to the primary the 
equivalent SCPI command: 
:SYST:COMM:ANAL:REL 

9. The equivalent SCPI command for the steps described above is as follows 
(modify the address string "127.0.0.1:5125" as needed): 
:SYST:COMM:ANAL:SEL "127.0.0.1:5125"



 130                                                                                                                                          Getting Started Guide

OperatingTasks: System-Level Tasks
True MIMO

Figure 4-22 IP and socket port addresses (traditional interface)

The procedure given above is for 2x2 MIMO; the process is the same for 3x3 or 
4x4 MIMO, except that more TRXs are added. 

The command equivalent for 3x3 MIMO would be: 
:SYST:COMM:ANAL:SEL "127.0.0.1:5125" 
:SYST:COMM:ANAL:SEL "127.0.0.1:5225" 
 
The command equivalent for 4x4 MIMO would be: 
:SYST:COMM:ANAL:SEL "127.0.0.1:5125" 
:SYST:COMM:ANAL:SEL "127.0.0.1:5225" 
:SYST:COMM:ANAL:SEL "127.0.0.1:5325"
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MIMO Modulation Analysis measurement SCPI commands
The following commands are used to set up the MIMO Modulation Analysis 
measurement.

Command Description Notes

[:SENSe]:EVMMimo:MTYPe DMAP|FOURier Matrix Type Sets the type as 
DMAP or Fourier

[:SENSe]:EVMMimo:TYPe M2M2|M3M3|M4M4 MIMO Type Sets the type as 
2x2, 3x3, or 4x4

[:SENSe]:EVMMimo:RESult:STReam <integer> MIMO Result Stream 
Index

Specifies the result 
stream by number.

[:SENSe]:EVMMimo:RESult:CHANnel <integer> MIMO Result Channel 
Index

Specifies the result 
channel by number.
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MIMO Modulation Analysis Results
The results available for a WLAN MIMO Modulation Analysis measurement are 
as follows (the results for Stream 3 are returned as -1.0 (not tested) in the case 
of 2x2 MIMO):

Index Result Parameter

0 Returns unprocessed I/Q trace data of Capture Interval, as a series of trace point values for Channel m. Channel 
index m can be set and queried through EVMM:RESult:CHAN command.  
 
The I values are listed first in each pair, using the 0 through even-indexed values. The Q values are the 
odd-indexed values.

1 Returns the comma-separated EVM results by stream. The EVM scalar results for each stream are in the 
following order: 
 
1. RMS EVM Max (dB)

2. RMS EVM Avg (dB)

3. Peak EVM Max (dB)

4. Peak EVM Avg (dB)

5. Pilot EVM Max (dB)

6. Pilot EVM Avg (dB)

7. Data EVM Max (dB)

8. Data EVM Avg (dB)

9. CPE EVM Max (dB)

10. CPE EVM Avg (dB)

When MIMO Type is 2x2, this result gives stream 1 EVM scalar results first, then stream 2 EVM scalar results. 
When MIMO Type is 3x3, stream 1, 2 and 3 EVM scalar results are provided in order. When MIMO Type is 4x4, 
returns 40 comma-separated EVM scalar results, provided in stream order.

2 Returns a value of the pass/fail (0.0 = passed, or 1.0 = failed) results determined by testing the result of RMS 
EVM. Only when all the stream RMS EVM Average results are passed, will this value be passed.

3 Returns series of floating point numbers that alternately represent I and Q pairs of the corrected measured 
trace for STRM m. Stream index m can be set and queried through EVMM:RESult:STReam command. 

The magnitude of each I and Q pair are normalized to 1.0, when the IQ Normalize is turned on. The first number 
is the in-phase (I) sample and the second is the quadrature-phase (Q) sample.

4 Returns series of floating point numbers (in dB) that represent each sample in the Stream EVM vs. Carrier trace 
of Capture Interval for STRM m. Stream index m can be set and queried through EVMM:RESult:STReam 
command. 

5 Returns series of floating point numbers (in dB) that represent each sample in the Stream EVM vs. Symbol trace 
of Capture Interval for STRM m. The first number is the symbol 0 decision point. Stream index m can be set and 
queried through EVMM:RESult:STReam command. 
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6 Returns series of floating point numbers that represent each sample in the Channel Response for STRM m CH k. 
Stream index m can be set and queried through EVMM:RESult:STReam command. Channel index k can be set 
and queried through EVMM:RESult:CHAN command. 

7 Returns comma-separated EVM scalar results by channel. The EVM scalar results for each channel are in the 
following order:  
 
1. RMS EVM Max (dB) 
2. RMS EVM Avg (dB) 
3. Peak EVM Max (dB) 
4. Peak EVM Avg (dB) 
5. Pilot EVM Max (dB) 
6. Pilot EVM Avg (dB) 
7. Data EVM Max (dB) 
8. Data EVM Avg (dB) 
9. Freq Error Max (Hz) 
10. Freq Error Avg (Hz) 
11. Freq Error Ppm Max (ppm) 
12. Freq Error Ppm Avg (ppm) 
13. Sym Clock Error Max (ppm) 
14. Sym Click Error Avg (ppm) 
15. IQ Gain Imb Max (dB) 
16. IQ Gain Imb Avg (dB) 
17. IQ Offset Max (dB) 
18. IQ Offset Avg (dB) 
19. IQ Quad Error Max (degree) 
20. IQ Quad Error Avg (degree) 
21. IQ Timing Skew Max (s) 
22. IQ Timing Skew Avg (s) 
23. Cross Pwr Max (dB) 
24. Cross Pwr Avg (db) 
25. Sync Corr Max 
26. Sync Corr Avg 
27. Avg Burst Power Max (dBm) 
28. Avg Burst Power Avg (dBm) 
29. Peak Burst Power Max (dBm) 
30. Peak Burst Power Avg (dBm) 
 
When MIMO Type is 2x2, 60 comma-separated scalar results are returned;  
When MIMO Type is 3x3, 90 comma-separated scalar results are returned; 
When MIMO Type is 4x4, 120 comma-separated scalar results are returned. 

8 Return the Channel Matrix results.

9 Return the decode bits of HT-SIG Signal.

10 Returns series of floating point numbers (in dB) that represent each sample in the Equalizer Impulse Response 
for STRM m CH k. Stream index m can be set and queried through EVMM:RESult:STReam command. Channel 
index k can be set and queried through EVMM:RESult:CHAN command. 

Index Result Parameter
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11 Returns comma-separated floating point numbers of spectral flatness trace for STRM m CH k. Stream index m 
can be set and queried through EVMM:RESult:STReam command. Channel index k can be set and queried 
through EVMM:RESult:CHAN command. 

12 Returns Data Rate (in Mbps) for MIMO input signals.

13 Returns the FFT SEM trace consisting of 5001 points if SEM is activated for Ch k. Chan index k can be set and 
queried through through EVMM:RESult:CHAN command.

14 Returns the SEM failed information consisting of  ( 2(DeltaFreq,DeltaAmplitude) x 6(OffsetA Lower, OffsetA 
Upper, OffsetB Lower, OffsetB Upper, Offset C Lower, Offset C Upper)=12 values in upper and lower bands of  
three offsets  for Ch k. Chan index k can be set and queried through through EVMM:RESult:CHAN command.

Index Result Parameter

When MIMO Type is 2X2 and Radio Standard is 80+80 MHz, all these 
measurement results are only for one segment. Use SCPI command 
EVMM:RESult:SEGMent to specify that these contents are the first segment 
results or the second segment results. 
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Tx Beam Forming 
If license V9077B-KFP is installed, Tx Beam-Forming results are available from 
the Modulation Analysis measurement in WLAN mode. 

Tx Beam Forming Commands

Two commands are added for Tx Beam Forming, as described in the table 
below. The first command sets up the measurement’s EVM demodulation 
algorithm to provide EVM results or Tx Beam Forming Results. The second 
command is used to specify the channel count of the measured MIMO signal.

Command Description

[:SENSe]:EVM:BFORming:MTYPe EVM|TXBFcal This command is only available when license 
V9077B-KFP is installed; otherwise, “-113, 
Undefined Header” error will be reported.

This parameter takes effect when the Radio 
Std is 802.11n(20MHz), 802.11n (40MHz), 
802.11ac (20MHz), 802.11ac (40MHz), 
802.11ac (80MHz) and 802.11ac (160MHz) 

When EVM is selected, the result index 1~20 
are calculated with meaningful values for 
EVM measurement, and result 21 and 22 
results are -999.0;

When TXBFcal is selected, the result index 
1~20 values will not be calculated; Instead, 
result 21 and 22 are calculated and returned

[:SENSe]:EVM:ACCHannel <integer> <real> For Radio Std 802.11n (20MHz) and 802.11n 
(40MHz), Tx Beam Forming with channel 
count <=4 is supported;

For Radio Std 802.11ac (20MHz), 802.11ac 
(40MHz), 802.11ac (80MHz), and 802.11ac 
(160MHz), Tx Beam Forming with channel 
count <=8 is supported
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Tx Beam Forming Results

The Tx Beam Forming results are added to the Modulation Analysis 
measurement results as Index 21 and Index 22, as described in the table below.

Index Result Parameter

21 Tx Beam Forming Calibrated Angle Error 
returns a series of floating point numbers (in rad) that represent the calibrated angle error vectors on channels, 
when 

- Radio Std is 802.11n (20 MHz), or 802.11n (40 MHz), and MIMO Tx Channel Count <= 4

- Radio Std is 802.11ac(20MHz), 802.11ac(40MHz), 802.11ac(80MHz), or 802.11ac(160MHz), and MIMO Tx 
Channel Count <= 8

- MIMO Usage Type is TXBForming (available when license V9077B-KFP is installed)

Otherwise, returns -999.0.

The first channel angle vector is used as reference; the angle error vectors are listed in order of channels. For 
the 20MHz BW signals, each channel’s angle error vector contains 64 values; For the 40MHz BW signals, each 
channels angle error vector contains 128 values; For the 80MHz BW signals, each channels angle error vector 
contains 256 values, For 160MHz BW signals, each channels angle error vector contains 512 values. 

22 Tx Beam Forming Gain  
returns gain after the calibrated angle error vector are compensated for the MIMO input signal, when 

- Radio Std is 802.11n (20 MHz), or 802.11n (40 MHz), and MIMO Tx Channel Count <= 4

- Radio Std is 802.11ac(20MHz), 802.11ac(40MHz), 802.11ac(80MHz), or 802.11ac(160MHz), and MIMO Tx 
Channel Count <= 8

- MIMO Usage Type is TXBForming (available when license V9077B-KFP is installed)

Otherwise, returns -999.0.
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E6640A Calibration Status
The E6640A EXM test set does not have a calibration certificate, because of its 
flexibility in configuration: 

— The E6640A chassis can have 1, 2, 3, or 4 TRXs (M943xA) installed.

— Different TRXs can have different hardware configurations for frequency 
range and/or bandwidth.

— Additional TRXs can be added to an E6640A chassis after the initial 
instrument purchase. These would have different calibration due dates, and 
different warranty end dates, from the modules that were originally 
purchased with the E6640A.

There isn’t a single instrument-level calibration (or calibration due-date) that 
covers the E6640A as a whole and all of the TRX modules (and the Reference 
module) within it. Each module is calibrated independently, and not 
necessarily at the same time that the others in the test set are calibrated. 

The only way to track the calibration status of the E6640A is to track the 
calibration status of the reference module, and each TRX module, within it. The 
serial number of a particular module can be found from its XSA window, by 
selecting System Settings > System > Show Hardware. The serial number is 
listed in the row which shows “Reference” or “M943x TRX” under Assembly 
Name. The same row also shows the Cal Date for the relevant module. 

The same information is available (in a different visual format) in the traditional 
interface (the menu path in that case is System > Show > Hardware).

Figure 4-23 Checking calibration status (MultiTouch interface)

The same hardware information is also returned by the SCPI command: 
SYST:CONF:HARD?
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Certificates of Calibration

Customers receive 2 to 5 Certificates of Calibration (COCs) with the E6640A 
EXM test set. The EXM is a scalable test set and can be purchased with 1 to 4 
TRX modules.  The TRX modules, along with the Reference module (supplied 
with each E6640A), are the only items that require calibration, and therefore 
they are the only items supplied with a CoC and calibration sticker at shipment. 

Each E6640A test set is shipped with a yellow envelope which contains your 
calibration certificates; this envelope is labeled (lower right corner) with a 
sticker identifying the unit model number (E6640A) and serial number.  Inside 
each envelope will be from two to five CoCs: one for the reference module,  and 
one for each of the TRX modules installed in the test set. This package 
constitutes your test set’s calibration data.

Figure 4-24 Certificates of calibration

You may choose to physically attach calibration stickers to your E6640A test 
set (recommended), or, as many customers do, you may choose to use the 
modules’ electronic calibration information to identify the calibration status of 
any module at any time.  The use of electronic calibration information is of 
benefit to those customers that may want to move modules from one 
instrument to another:  the calibration date always follows the module.

To summarize: calibration of the E6640A is not done at the instrument level, 
but an E6640A is fully calibrated when all of the modules (Reference module 
and TRX modules) are calibrated. At initial shipment, this information is 
provided in the yellow envelope supplied with each unit.
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Alignments (MultiTouch Interface)
Alignments are internal calibration adjustments which each TRX module must 
make to ensure that internal signal levels are properly maintained. To avoid 
interruptions, the alignments are not run automatically, either at startup or 
afterward; you must run them explicitly. (See also: “Alignments (Traditional 
Interface)” on page 142).

The System Settings > Alignments > Align Now menu is illustrated below.

Figure 4-25 Alignments > Align Now menu

“All” Alignment (daily use)

This alignment of the source and analyzer in the TRX is sufficient to maintain 
specified performance, provided that (1) the TRX’s internal temperature has 
not drifted more than 5 degrees C since the previous alignment, (2) no more 
than 8 hours have elapsed since the previous “All” alignment, and (3) no more 
than 1 week has elapsed since the previous weekly alignment (see below). The 
“All” alignment typically takes less than 5 minutes to run.

The TRX’s internal temperature can be checked by sending the SCPI query 
:CAL:TEMP:CURR?

To run the alignment, select System Settings> Alignments > Align Now  > 
Align Now All, or send the SCPI command :CAL:ALL.

The alignment process requires a 45-minute preliminary warm-up period, after 
applying power or after restarting the XSA application (when the application is 
not running, power is not applied to the TRXs; therefore an application shutdown 
has the same effect on alignment as a power shutdown). 
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Weekly alignment procedure

A more thorough alignment of the source and analyzer in the TRX is required 
on a weekly basis. This procedure is similar to the “All” alignment described 
above, but it also performs additional alignment functions related to 
slow-drifting parameters which do not change significantly over time periods 
shorter than a week. This alignment procedure should be run whenever the 
TRX’s internal temperature has drifted more than 5° C since the previous "All" 
alignment (see “Alignment statistics” on page 141), or whenever more than 7 
days have elapsed since the previous weekly alignment. 

Perform the alignment procedure as follows:  

1. Select System Settings > Alignments > Align Now> Align All But RF, or 
send the SCPI commands: 
:CAL:NRF 
*WAI

2. Select System Settings > Alignments > Align Now > Align Source, or 
send the SCPI commands: 
:CAL:SOUR 
*WAI

3. Select System Settings > Alignments > Align Now > Align Now IF, or send 
the SCPI commands:  
:CAL:IF 
*WAI

This alignment process also requires the same 45-minute 
preliminary warm-up period described under ““All” Alignment 
(daily use)” on page 142. 
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Alignment statistics

The TRX’s internal temperature and the time since the most recent alignment 
can be checked by selecting System Settings> Alignments > Show 
Alignment Statistics, as illustrated below.

Figure 4-26 Show Alignment Statistics
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Alignments (Traditional Interface)
Alignments are internal calibration adjustments which each TRX module must 
make to ensure that internal signal levels are properly maintained. To avoid 
interruptions, the alignments are not run automatically, either at startup or 
afterward; you must run them explicitly. (See also: “Alignments (MultiTouch 
Interface)” on page 139).

“All” Alignment (daily use)

This alignment of the source and analyzer in the TRX is sufficient to maintain 
specified performance, provided that (1) the TRX’s internal temperature has 
not drifted more than 5 degrees C since the previous alignment, (2) no more 
than 8 hours have elapsed since the previous “All” alignment, and (3) no more 
than 1 week has elapsed since the previous weekly alignment (see below). The 
“All” alignment typically takes less than 5 minutes to run.

The TRX’s internal temperature can be checked by sending the SCPI query 
:CAL:TEMP:CURR?

To run the alignment, select System > Alignments > Align Now > All, or send 
the SCPI command :CAL:ALL.

The alignment process requires a 45-minute preliminary warm-up period, after 
applying power or after restarting the XSA application (when the application is 
not running, power is not applied to the TRXs; therefore an application shutdown 
has the same effect on alignment as a power shutdown). 
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Weekly alignment procedure

A more thorough alignment of the source and analyzer in the TRX is required 
on a weekly basis. This procedure is similar to the “All” alignment described 
above, but it also performs additional alignment functions related to 
slow-drifting parameters which do not change significantly over time periods 
shorter than a week. 

1. Select System > Alignments > Align Now > IF, or send the SCPI 
commands: 
:CAL:IF 
*WAI

2. Select System > Alignments > Align Now > RF, or send the SCPI 
commands: 
:CAL:RF 
*WAI

3. Select System > Alignments > Align Now > Source, or send the SCPI 
commands: 
:CAL:SOUR 
*WAI

Figure 4-27 Alignment menus

This alignment process also requires the same 45-minute 
preliminary warm-up period described under ““All” Alignment 
(daily use)” on page 142. 
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Alignment statistics

The TRX’s internal temperature and the time since the most recent alignment 
can be checked by selecting System > Alignments > Show Alignment 
Statistics, as illustrated below.

Figure 4-28 Show Alignment Statistics
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LAN Address Configuration
The E6640A supports both dynamic and static assignment of its IP address, 
using ports LAN 1 and LAN 2 respectively.

The LAN 1 port is designed for dynamic IP addressing, using the Dynamic Host 
Configuration Protocol. If the your site network supports DHCP, the E6640A 
will be assigned an IP address automatically when it is connected to the LAN. 
Once the address is assigned, it is listed, along with the computer name, under 
System Settings [Gear Icon] > System > Show System. The address or 
computer name can be used to find the test set on the LAN. However, to see 
the Show System screen and find this information, it is necessary either to 
connect a monitor to the front panel monitor port, or else to use the LAN 2 port 
to connect test set to a PC directly. 

The same information is available (in a different visual format) in the traditional 
interface (the menu path in that case is System > Show > System).

Figure 4-29 Checking the LAN address

Using the LAN 1 port to connect the test set directly to the public LAN is 
potentially insecure, because the test set does not provide anti-virus 
protection. Connecting the test set to the public LAN by way of a PC with 
antivirus protection is the preferred solution. 

The LAN 2 port is designed to use a private static IP address, 192.168.1.2 
(changing this address is possible but not recommended). This port can be 
used for direct connection to a PC. 

 The menu path using the old interface is: 
 System > Show > System. 
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To find the test set on the LAN, you will need to know its IP address or 
computer name. If you cannot easily obtain a monitor view of System > Show 
> System, you can determine the computer name using the instrument serial 
number. The computer name is in the format K-E6640A-nnnnn, ending in the 
last five digits of the serial number. 
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Managing Licenses
Licenses can be tied to a particular instrument, or transferable from one 
instrument to another by various means.

Licenses can be either time-based or perpetual (the latter have no expiration 
date).

To verify which licenses are installed, open the Keysight License Manager from 
the Windows Start menu. (In the MultiTouch interface, it can also be opened 
by clicking the "gear" icon at the upper left to open the System Settings 
screen, and clicking Licensing > License Manager.) The licenses installed on 
the test set are listed, with information provided about license types and 
expiration dates (in the illustrated example, "Fixed" indicates a node-locked 
license). 

Figure 4-30 Installed licenses (as displayed in Keysight License Manager)
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Flexible Software Licensing 

Keysight offers a variety of flexible licensing options to fit your needs and 
budget. You have two or more options to choose from for the license term, 
license type, and KeysightCare software support subscription.

License Terms

— Perpetual:  
License can be used indefinitely.

— Time-based:  
License can be used through the term of the license only (6, 12, 24, or 36 
months).

License Types

— Node-locked:  
License can be used on one specified instrument/computer.

— Transportable:  
License can be used on one instrument/computer at a time but may be 
transferred to another using Keysight Software Manager (internet 
connection required).

— USB Portable:  
License can be used on one instrument/computer at a time but may be 
transferred to another using a certified USB dongle (available for additional 
purchase with Keysight part number E8900-D10).

— Floating (single site):  
Networked instruments/computers can access a license from a server one 
at a time. Multiple licenses can be purchased for concurrent usage.

KeysightCare Software Support Subscriptions

— Perpetual licenses are sold with a 12 (default), 24, 36, or 60-month software 
support subscription. Support subscriptions can be renewed for a fee after 
that.

— Time-based licenses include a software support subscription through the 
term of the license.

See also: “Licensing New Measurement Application Software - After Initial 
Purchase” on page 68 and “Transporting a License Between Test Sets” on 
page 70. 

For More information

On licensing in general: 
www.keysight.com/find/licensingwww.keysight.com/find/licensing

On upgrading software: 
www.keysight.com/find/upgrade_to_software_support

www.keysight.com/find/licensing
www.keysight.com/find/licensing
www.keysight.com/find/licensing
www.keysight.com/find/licensing
www.keysight.com/find/upgrade_to_software_support
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5 Operating Tasks: Receiver Setup

The following topics can be found in this section:

“Measurement Setup (MultiTouch Interface)” on page 150

“Measurement Setup (Traditional Interface” on page 154

“Marker Setup (MultiTouch Interface)” on page 157

“Marker Setup (Traditional Interface)” on page 159
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Measurement Setup (MultiTouch Interface)
The analyzer/receiver function of the E6640A relates to measurement of 
signals received from the DUT. 

Clicking on the measurement tab at the upper left corner of the display opens 
the Mode/Measurement/View Selector, which you can use to select a 
particular kind of measurement. In this example, WLAN has been selected 
under Mode, and the selections under Measurement are the measurements 
available in that mode. (For some measurements, there are also selections to 
be made under View.) In the example illustrated below, the Channel Power 
measurement is selected. Click OK to run this mode/measurement selection. 

Figure 5-1   Selecting Mode/Measurement
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Most measurement settings are made from the menus, which can be accessed 
by selecting the dropdown button near the upper right of the display.

Figure 5-2   Accessing Menus

Selecting a menu from the dropdown list displays the menu selections (usually 
the selections are indented under multiple tabs shown at the right). 

For example, the Amplitude menu has three tabs; the selections under the Y 
Scale and Range tabs are shown below.
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Figure 5-3 Measurement Menus

Although some menu choices involve only a simple selection (Top | Center | 
Bottom) or a value to be entered (O dBm), some choices cause a more 
elaborate selection screen to appear in the display. In the example illustrated 
below, Trigger > Trigger Settings Diagram opens an interactive display (the 
trigger source can be changed from Free Run to Ext 1 by clicking on the 
graphic).

Figure 5-4 Trigger Settings Diagram
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Another type of complex screen which some menu selections open is a 
configuration window such as the Meas Setup Summary Table, which gathers 
together multiple settings on one screen to make it easier to review them. 

Figure 5-5 Meas Setup Summary Table

The menu choices are different for each measurement. For more detailed 

information, see the help file for the 5G application. 
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Measurement Setup (Traditional Interface
The analyzer/receiver function of the E6640A relates to measurement of 
signals received from the DUT. 

Menus are accessed from the the Virtual Front Panel popup window. To open 
the VFP, right-click on the display and select Utility > Virtual Front Panel in 
the temporary menu which appears.

Click the Mode button and select the desired mode (using the More function as 
necessary to see all the available choices). In this example, WLAN is selected.   

Figure 5-6   Selecting a mode 
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Click the Meas button on the VFP and select the desired measurement (using 
the More function as necessary to see all the available choices). In this 
example, the Channel Power measurement is selected.   

Figure 5-7   Selecting a measurement 

Settings for the selected measurement are made by selecting other menus.

Figure 5-8   Accessing menus
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Where a menu setting requires a numerical value, use the numeric keypad at 
the lower right corner of the VFP to enter the number required. 

Figure 5-9 Selecting menu settings
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Marker Setup (MultiTouch Interface)
Multiple markers can be set up on the measurement display. Under Marker > 
Select Marker, choose the marker of interest and select Settings for it such as 
Marker Frequency and Marker Mode.

Figure 5-10 The Marker/Settings menu

The currently selected marker can be moved simply by dragging it, but it can 
also be positioned more precisely by entering a specific Marker Frequency for 
it.

Figure 5-11 Changing marker frequency with cursor (left) or keypad (right)

Click Marker Settings Diagram on the Settings menu to display an interactive 
graphic showing the settings and dependencies of all markers at once. Click on 
a numbered Marker to select it and change its mode to Normal, Off, or Delta. 
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(If Delta is selected, the marker is used with reference to another marker at a 
different frequency, to show the difference between trace amplitudes at those 
two points on the spectrum.)

To define Marker 2 as a delta marker referenced to Marker 1, first click on the 
Marker 1 icon and drag it to the space occupied by the Reference Marker icon 
directly under the Marker 2 icon; this makes Marker 1 the reference marker for 
Marker 2. Click on the Marker 2 icon to select it, and set the Marker Mode to 
Delta.

Figure 5-12 The Marker Settings Diagram

The illustration below shows the difference between Normal mode and Delta 
mode. When Marker 2 is set to Normal, it displays the actual amplitude at that 
marker frequency. When Marker 2 is set to Delta, it displays the difference 
between amplitude at Marker 2 and amplitude at Marker 1.

Figure 5-13 The Marker/Settings menu
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Marker Setup (Traditional Interface)
Multiple markers can be set up on the measurement display. Click Marker on 
the VFP to open the Marker menu, and click Select Marker to choose the 
particular marker for which you want to make settings. 

Figure 5-14 The Marker > Select Marker menu

If the marker is Off, change it to Normal so that you can see its frequency 
displayed. Use the numeric keypad on the VFP to set its frequency. The 
frequency can also be adjusted by dragging it left or right on the display.

Figure 5-15 Viewing and changing marker frequencies
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In the example setup below, Marker 1 is configured as Normal, and Marker 2 is 
configured as Delta. Under Properties, set Marker 2 as Relative To 1. When 
Marker 1 is selected, its frequency is displayed, as well as the measured power 
at that frequency. When Marker 2 is selected, the values displayed indicate 
how much the frequency and measured power at Marker 2 differ from the 
values for Marker 1 (specifically, Marker 2 is 120 kHz higher in frequency, and 
18.849 dB lower in power, than Marker 1).

Figure 5-16 Setting up a Delta marker
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6 Operating Tasks: Source Setup

The following topics can be found in this section:

“General RF Source Setup” on page 162

“Loading and Running Waveform Files (Traditional Interface)” on page 166

“Creating Waveform Sequences (Traditional Interface)” on page 170

“Creating Waveform Sequences (MultiTouch Interface)” on page 168

“Using Waveform Markers” on page 173

“Locking Waveform Files (MultiTouch Interface)” on page 179

“Locking Waveform Files (Traditional Interface)” on page 181

“Locking Waveform Files (MultiTouch Interface)” on page 179

“Header Utilities (Traditional Interface)” on page 184
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General RF Source Setup
The source function of the E6640A relates to generation of test signals to be 
transmitted to the DUT. (Not all measurement scenarios require these signals, 
but many do.) 

In the MultiTouch interface, most source settings are made from the 
Input/Output > RF Source menu. In the Traditional interface, they are made 
from the Source menu. Both are illustrated below.

Figure 6-1 Source menus in the MultiTouch (left) and Traditional interfaces
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Loading and Running Waveform Files (MultiTouch Interface)
The Modulation Setup > ARB Setup window can be used to configure various 
functions of the arbitrary waveform generator, and to select which waveform 
files it plays.

Figure 6-2 ARB Setup Window
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Basic Control is used to set markers and triggers, and to select waveform files 
as illustrated below. Click Select Waveform to choose a waveform file that is 
currently in ARB memory. If a desired waveform file is not currently shown in 
the Segments in ARB Memory list, use Recall Waveform to load it.

Figure 6-3 Basic Control (ARB Setup)

A waveform file can also be recalled directly from the File >Recall window:



Getting Started Guide                                                                                                                                          165

Operating Tasks: Source Setup
Loading and Running Waveform Files (MultiTouch Interface)

Figure 6-4 Recalling an ARB file (Recall function)
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Loading and Running Waveform Files (Traditional Interface)
The Source > Modulation Setup > ARB menu can be used to configure various 
functions of the arbitrary waveform generator, and to select which waveform 
files it plays.

Figure 6-5 ARB Setup Window
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The ARB Waveform menu and its submenus are used to control which 
waveforms are in ARB memory. Click Segments on Hard Disk to see a list of 
available waveform files on the hard disk drive (use the Current Directory or 
Default Directory selections to navigate to a different directory on the hard 
drive if necessary). Select a waveform file and click Load Segment to ARB 
Memory to add it (or use Load All to add all available waveform files at once).

If you want to remove a waveform file from ARB memory, click Segments in 
ARB Memory, and remove a selected waveform or all of them. 

Figure 6-6 ARB Waveform menu and sub-menus
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Creating Waveform Sequences (MultiTouch Interface)
Waveform Sequences (under ARB Setup) is used to create a sequence of 
waveform files to be played in order:

1. Click Build New Sequence.

2. In the window which opens, click Insert Waveform (this opens a window 
showing the waveforms that are in ARB memory. To add a waveform to the 
sequence, select it and click OK. Repeat this process to add more.

3. To add waveforms that are not shown in the table, use the Recall 
Waveform function to load them into ARB memory.

4. When you have all the waveforms added, and you’ve made the desired 
settings for their repetitions and markers, click Save Sequence.

Figure 6-7 Waveform sequences (ARB Setup)
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Using the waveform sequence (MultiTouch interface)

Once a waveform sequence file (.seq) has been saved, it can be used as if it 
were a regular waveform file (.wfm). In the Recall Waveform window, change 
the displayed File Type to Waveform Sequence Files and select the desired 
file, which is then loaded into ARB memory, and can be used in place of a 
waveform file.

Figure 6-8 Loading a waveform sequence (ARB Setup)



 170                                                                                                                                          Getting Started Guide

Operating Tasks: Source Setup
Creating Waveform Sequences (Traditional Interface)

Creating Waveform Sequences (Traditional Interface)
To create a sequence of waveform files to be played in order, go to the Source 
menu and select Modulation Setup > ARB >Waveform Sequences > Build 
New Sequence > Insert New Waveform.

Figure 6-9 Navigating to the Insert New Waveform menu

If the waveform segments you want to add to the waveform sequence are 
already loaded into ARB memory, you can select them from the displayed list 
of segments and click Insert Waveform. However, it is usually necessary as a 
first step to click Segments on Hard Disk, so that you can see all saved 
waveform segments and move the ones you want into ARB memory.

Figure 6-10 Obtaining waveform segments from the hard drive
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Select any waveform segments you need from the hard drive and click Load 
Segment to Arb Memory.

Figure 6-11 Loading waveform segments into ARB memory

When the desired segments are in ARB memory, click Insert Waveform to add 
them to the waveform sequence. Click Save Sequence when the segments are 
added (a file-explorer window opens, so that you can chose the file path).

Figure 6-12 Loading waveform segments into waveform sequence
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Using the waveform sequence (Traditional interface)

Once a waveform sequence file (.seq) has been saved, it can be used as if it 
were a regular waveform file (.wfm). On the Source menu, select Modulation 
Setup > ARB > Select ARB > Segments on Hard Disk.

Figure 6-13 Finding a saved sequence

Use Current Directory to navigate to where you saved the sequence. Select 
the sequence and click Load Segment to ARB Memory. 

Figure 6-14 Loading a waveform sequence 
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Using Waveform Markers
ARB waveform files played by the source in the E6640A include markers within 
the waveform data, together with settings for these markers included in the 
header of the waveform file. One of these markers can designated for RF 
blanking of the source output (that is, RF power is on only during the marker 
event). 

The markers can also be used to generate trigger outputs at the Trig 1 and 
Trig 2 connectors on the front panel. 

The overall operation of waveform markers is illustrated in the diagram below.

Figure 6-15 Waveform markers
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Waveform Marker Settings (MultiTouch Interface)

The marker settings included in the ARB file header can be viewed from the 
Input/Ouptut > RF Source > Modulation Setup > ARB Setup screen, under 
Basic Control or under Header Utilities. Although settings can be changed in 
either of these places, the changes to the header can only be saved by using 
the Save Header button under Header Utilities.

Figure 6-16 Marker settings in ARB file header

Marker Polarity settings determine whether the trigger is rising (Positive) or 
falling (Negative).

ALC Hold settings have no effect in model E6640A. 

RF blanking is set up by Marker Routing (under Basic Control) or by RF 
Blanking Routing under Header Utilities. The possible settings include:

— None (no RF blanking)

— Marker 1, 2, 3, or 4 (RF is off during the numbered marker selected here) 

— Per Arb (this selection, although sometimes visible in the user interface, is 
not applicable to Model E6640A)

The exact result of these settings depends upon how markers were created in 
the ARB waveform file.
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Waveform Marker Settings (Traditional Interface)

To view or alter marker settings included in the ARB file header, go to the 
Source menu and select Modulation Setup > ARB > Marker Utilities. Use the 
Marker Polarity menu to set the polarity of the four waveform markers as 
positive or negative. Use the Marker Routing menu to choose which of the four 
markers (or none) is used for RF Blanking.

Figure 6-17 Marker settings in ARB file header

The exact result of these settings depends upon how markers were created in 
the ARB waveform file.
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Select Utilities to see marker settings in the header file. 

Figure 6-18 Marker settings in ARB file header
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Generating Trigger Outputs (MultiTouch Interface)

The waveform markers can be used to generate triggers at the Trig 1 and  
Trig 2 outputs on the front panel. In the Input/Output > Trigger Output menu, 
separate settings are available for Trig 1 Out and Trig 2 Out. 

Select Source Marker N and choose Source as the output device.

Figure 6-19 Using waveform markers to generate trigger outputs

In selecting a marker under Trig 1 Out or Trig 2 Out, the options include Off 
(no output trigger), Marker N (choose a numbered marker), or Source Per Arb. 
(The latter option does not apply to the E6640A model.)
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Generating Trigger Outputs (Traditional Interface)

The waveform markers can be used to generate triggers at the Trig 1 and  
Trig 2 outputs on the front panel. In the Input/Output > Trigger Output menu, 
separate settings are available for Trig 1 Out and Trig 2 Out. 

Figure 6-20 Using waveform markers to generate trigger outputs
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Locking Waveform Files (MultiTouch Interface)
The measurement applications which run on the E6640A can have a "Y" license 
(which supports unrestricted use of waveform files by the internal source) or a 
"V" license (a measurement-oriented license which limits the source to a fixed 
number of slots into which waveforms can be locked). For example, the license 
Y9085EM0E supports unrestricted use of waveform files in the 5GNR mode; 
the license V9085EM0E is also for the 5GNR mode but limits the source to 
waveforms already locked in slots.

If you are using a "V" license, you will have to lock a waveform into a slot in 
order to use it. Open the Waveform Utilities window under Arb Setup. Select 
the waveform from the list of files in ARB memory and click OK. (If a waveform 
you want is not shown in the table, use the Recall Waveform function to load it 
into ARB memory.)

Figure 6-21 Waveform Utilities: adding a waveform

If you have previously added a waveform file, but you removed it rather than 
locking it, that file name becomes unusable here; the interface will not allow you 
to add a new waveform file with the same name as a file added previously, even if 
that file is no longer shown in a slot.



 180                                                                                                                                          Getting Started Guide

Operating Tasks: Source Setup
Locking Waveform Files (MultiTouch Interface)

To lock a waveform into a slot, highlight the name of the waveform in the list 
and click Lock Waveform In Slot. A confirmation window appears, giving you 
an opportunity to cancel if you don’t want the slot permanently assigned.

Figure 6-22 Waveform Utilities: adding a waveform
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Locking Waveform Files (Traditional Interface)
The measurement applications which run on the E6640A can have a "Y" license 
(which supports unrestricted use of waveform files by the internal source) or a 
"V" license (a measurement-oriented license which limits the source to a fixed 
number of slots into which waveforms can be locked). For example, the license 
Y9085EM0E supports unrestricted use of waveform files in the 5GNR mode; 
the license V9085EM0E is also for the 5GNR mode but limits the source to 
waveforms already locked in slots.

If you are using a "V" license, you will have to lock a waveform into a slot in 
order to use it. Open the Source menu and select Modulation Setup > ARB > 
Waveform Utilities > Multi-Pack Licenses.

Figure 6-23 Waveform Utilities: finding the Multi-Pack Licenses menu
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Click Segments on Hard Disk and move the desired waveform into ARB 
memory. Click Add Waveform to add the selected waveform into a license slot. 
A confirmation window appears, giving you an opportunity to cancel if you 
don’t want the slot permanently assigned. 

To lock a waveform into a slot, highlight the name of the waveform in the list 
and click Lock Waveform In Slot. A confirmation window appears, giving you 
an opportunity to cancel if you don’t want the slot locked. 

Figure 6-24 Waveform Utilities: adding a waveform

If you have previously added a waveform file, but you removed it rather than 
locking it, that file name becomes unusable here; the interface will not allow you 
to add a new waveform file with the same name as a file added previously, even if 
that file is no longer shown in a slot. 



Getting Started Guide                                                                                                                                          183

Operating Tasks: Source Setup
Header Utilities (MultiTouch Interface)

Header Utilities (MultiTouch Interface)
The Header Utilities window displays information from the header of the 
current waveform file or waveform sequence file. Settings which are shown in 
white rather than gray (such as Sample Rate and Marker Polarity) are 
editable; to save your changes to these settings, click Save Header.

ALC Hold settings have no effect in model E6640A. However, the setting for RF 
Blanking is functional and can be selected here.

Figure 6-25 Header Utilities (ARB Setup)
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Header Utilities (Traditional Interface)
Select the Source menu and select Modulation Setup > ARB > Header 
Utilities to view the header of the current waveform file or waveform sequence 
file. The Current Settings column reveals differences between settings 
included in the file and settings that have been made using menus. (To save 
those modified settings to the header file, click Save Setup To Header.

ALC Hold settings have no effect in model E6640A. However, the setting for RF 
Blanking is functional and can be selected here.

Figure 6-26 Header Utilities 
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7 Windows Operating System

The following topics can be found in this section:

“Navigating Windows Without a Mouse” on page 186

“Remote Desktop: Using the Test Set Remotely” on page 187

“Programmatic Control of the Test Set” on page 202

“Capturing/Printing Displays and Windows” on page 203

“Windows Shortcuts and Miscellaneous Tasks” on page 204
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Navigating Windows Without a Mouse

Table 7-1 Key functions

Key Presses Actions

Esc Exits/closes a Windows dialog box (does not exit an Application 
window)

Enter Does the current "default action". If a menu item or a button is 
currently highlighted, then the Enter key activates that menu item or 
button.

Alt Moves focus/control to the pull down menus bar in the active Window

Right Arrow In pull-down menu: opens the next menu to the right, or opens a 
submenu

In a dialog box: selects an option button

Left Arrow In pull-down menu: opens the next menu to the left, or opens a 
submenu

In dialog box: selects an option button

Up Arrow In pull-down menu: Moves to next selection up in the menu

In dialog box: selects an option button

Down Arrow In pull-down menu: Moves to next selection down in the menu

In dialog box: selects an option button

Tab In dialog box: moves to the next/previous field

Del Deletes the currently selected item

Alt + Tab Switches between the next/previous Application

Alt + Enter Shows the Properties of the currently selected item

Alt + Esc Cycles through items in the order that they had been opened

Backspace In My Computer or Windows Explorer: move up one level

In Internet Explorer: works like the BACK arrow key

Ctrl + Left arrow Moves to the left one word at a time

Ctrl + Right arrow Moves to the right one word at a time

Ctrl + Tab In dialog box: moves to the next/previous Tab location

Alt + Space Opens the window control menu for the currently active window, 
allowing you to minimize, maximize, move and restore (size) the 
window

Ctrl + Esc Opens the Windows Start Menu

Ctrl + Alt + Delete Opens the Windows Task Manager
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Remote Desktop: Using the Test Set Remotely
Windows Remote Desktop is recommended for remote control of the test set. 

Overview of Remote Desktop operation

Using the Remote Desktop functionality of the test set allows you to control 
and interact with the test set from a remote computer, as though you were 
sitting in front of the test set.

When you have configured the test set for remote connectivity, and configured 
a separate computer to act as a Remote Desktop Host, you can send 
commands to the test set from the remote computer, and you can see the test 
set display on the screen of the remote computer.

This section provides full details of how to set up the test set for remote 
connectivity, and also how to set up a computer running any 32-bit version of 
Microsoft Windows as a Remote Desktop Host.

The Remote Desktop functionality is a Microsoft Windows capability. The 
following discussion provides some guidelines for using this capability with the 
test set. You need to refer to the Windows help documentation for more 
information. As Windows evolves, these instructions may no longer be exact.
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Setting up Remote Desktop operation

Setting up the test set

Before the test set can be controlled through a Remote Desktop Connection, it 
must be set up to allow connection from a remote computer. 

Setting up the remote computer

The procedure depends on whether the Remote Computer to be set up is 
running Windows XP, Windows 7, or another version of Microsoft Windows.

Remote computer running Windows XP or Windows 7

Windows XP and Windows 7 include the Remote Desktop Connectivity Client 
software, so no additional setup is required.

Remote computer running another version of Windows

You can use any 32-bit version of Windows (Windows 95, 98, ME, NT4, or 
2000) to install and run the Client software for Remote Desktop Connectivity. 
However, you need to have available a Windows XP or Windows 7 installation 
CD-ROM, because that contains the Client software.

Table 7-2 Setting up a remote desktop connection

Step Notes

1 To perform this operation successfully, you 
must have Administrator level access to the 
test set.

The default Administrator password is: 
Keysight4u!

2 On the test set, open the Windows Control 
Panel.  
Using the Virtual Front Panel within the test 
set application, press System > Control 
Panel.  
Or, from the Windows Desktop, click Start > 
Control Panel. 

3 Within the Control Panel, select System > 
System and Security.  

4 Click Remote Settings.  A System Properties window appears, with the 
Remote tab displayed.

5 Check the box labeled Allow Remote 
Assistance connections to this computer, if 
it is not already checked. 

 

6 To add users, click Select Users > Add. Follow the on-screen instructions.
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How to locate the computer name of the test set

To connect a remote computer to the test set, you need to know its Computer 
Name. The Computer Name can be displayed as follows:

The following instructions relate to software provided by Microsoft Corporation. 
Keysight offers no warranty regarding the operation of such software. The 
procedure described here may be changed by Microsoft at some future time.

Table 7-3 Installing the Client software

Step Notes

1 When the Welcome Screen appears, click 
Perform additional tasks.

2 From the What do you want to do? 
screen, click Set up Remote Desktop 
Connection. 

The Remote Desktop Connection InstallShield 
Wizard appears. 

3 Click Next. Follow the on screen instructions provided by the 
Wizard.

4 To access the installed software, click Start 
> All Programs > Accessories > 
Communications > Remote Desktop 
Connection. 

Table 7-4 Locating the name from the Keysight application

Step Notes

1 On the test set front panel, press System > 
Show > System.

A page listing various parameters appears.The 
test set’s computer name is shown in the list next 
to the title Computer Name. 

Table 7-5 Locating the name from the Windows desktop (with a mouse)

Step Notes

1 Click Start > Control Panel. In the Control Panel window, select System 
and Security > System. 

2 The computer name is displayed in the 
System window, under the heading 
“Computer name, domain, and workgroup 
settings”. 

The computer name is listed as Full computer 
name.
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Table 7-6 Locating the name from the Windows desktop (without a mouse)

Step Notes

1 Press Ctrl+Esc to display the Windows 
Start menu. 

2 Use the Up Arrow or Down Arrow keys to 
select the Control Panel item. 

 

3 Press Enter to open the Control Panel 
dialog. 

 

4 Use the Tab key to highlight System and 
Security, then press Enter. 

The System and Security window is 
displayed. 

5 Use the Tab key to highlight System, then 
press Enter. 

The System window is displayed. 

6 The computer name is displayed in the 
System window, under the heading 
Computer name, domain, and 
workgroup settings. 

The computer name is listed as Full computer 
name.

7 To close the Control Panel dialog: 
Press Alt to open the drop-down File menu 
Press the Down Arrow until the Close 
menu item is selected 
Press Enter to close the Control Panel 
dialog. 
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Running a Remote Desktop session

Initializing a Remote Desktop session

After setting up both the test set and the remote computer for Remote Desktop 
Connectivity, as described in “Setting up Remote Desktop operation” on 
page 188, you are ready to start a Remote Desktop session.

The test set display appears on the screen of the remote computer. Because 
the test set front-panel keys are not available when using the test set remotely, 
three alternative methods are available to perform the functions of the 
front-panel keys, as detailed in the following sections: 

— “Accessing menus for Remote Desktop operation” on page 195

— “Keycode commands for Remote Desktop operation” on page 196

— “The Virtual Front Panel” on page 201

To initialize a Remote Desktop Session, you need to know the Computer Name 
of the test set. This information can be shown on the test set display by 
following the procedure in the section “How to locate the computer 
name of the test set” on page 189.

Table 7-7 Starting a session

Step Notes

1 Click Start > All Programs > 
Accessories > Remote Desktop 
Connection.

A Remote Desktop Connection dialog appears:

2 Enter the computer name or IP address of the 
test set. 

3 Click Connect. A login dialog box appears.

4 Enter the login account name and password. The default account name is Instrument and the 
default password is measure4u, but these 
parameters may be changed by instrument users.

 Only the current User or an Administrator can remotely log into the test set. To 
see who the current user of the test set is, press Ctrl+Esc on the test set until 
you can view the current user name on the Start menu. If no one is currently 
logged into the test set, any valid instrument user can remotely log in.
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Setting Remote Desktop options

Table 7-8 Setting options

Step Notes

1 On the Remote Desktop Connection window, 
click Options. The window expands 
vertically to show several configuration tabs.

The Options dialog has several tabs. Generally, the default 
settings are correct. 

2 Under the General tab, ensure that the 
Computer name, User name and 
Domain name are set correctly.  

You may choose to enter the password and save it for future 
sessions, by checking the Save my password box.
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3 Click the Display tab. 
 
Under Remote desktop size, you may 
select the size of the window in which the 
test set display appears. Do not select any 
size smaller than 1024 x 768 pixels. Selecting 
a remote desktop size smaller than 1024 x 
768 results in the test set display not being 
fully visible. In such circumstances, scroll 
bars do not appear, so portions of the display 
are not accessible. 
Under Colors, you may select any setting 
that uses 15 bits or more. Selecting a color 
setting that uses less than 15 bits results in 
dithering and incorrect color rendition of the 
remote desktop window. 

4 Click the Local Resources tab. 
 
Click the More button to see a selection of 
local resources; selecting the Drives 
checkbox enables you to transfer data 
between the remote desktop and the local 
PC.  
 
To transfer data, click Start on the task bar 
of the remote computer, then click My 
Computer. Explorer opens on the remote 
computer and displays the drives of both the 
remote computer and the local computer. You 
can now copy and paste between the two 
disk drives. 

Table 7-8 Setting options

Step Notes
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5 Click the Experience tab. To Optimize the performance of the Remote Desktop session, 
choose the appropriate connection format from the drop-down 
list.

Table 7-8 Setting options

Step Notes
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Accessing menus for Remote Desktop operation

Using the mouse, right-click the application display window to access the 
following remote desktop menus:

The function of each selection in the menu is generally identical to that of the 
corresponding Virtual Front Panel key. The following lists additional 
functionality:

Exit – Selecting this item closes the Application software.

Utility > Page Setup – Selecting this item opens a printer setup dialog.

Utility > Virtual Front Panel – Selecting this item opens the Virtual Front 
Panel window, as described in the Section “The Virtual Front Panel” on 
page 201.

The menus are also available when using the test set directly, provided that a 
mouse or other pointing device is attached to it.
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Keycode commands for Remote Desktop operation

When using the test set in remote desktop mode, the following combinations 
of remote keyboard keys can be used to perform the operation of the virtual 
front-panel keys.

Figure 7-1 Keycodes
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Table 7-9 Keycode commands

To initiate the following virtual key: Press these keys on the remote computer 
keyboard:

AMPTD Y Scale Ctrl+Shift+A

Auto Couple Ctrl+Shift+C

Bk Sp Backspace

BW Ctrl+Alt+B

Cancel (Esc) Esc

Cont Ctrl+Alt+C

Ctrl Ctrl

Decrease Audio Volume Volume Control slider

Del Delete

Down Arrow Down Arrow

Enter Enter (Return)

File Ctrl+F

FREQ Channel Ctrl+Shift+F

Full Screen Ctrl+Shift+B

Help F1

Increase Audio Volume Volume Control slider

Input/Output Ctrl+Shift+O

Left Arrow Left Arrow

Marker Ctrl+Alt+K

Marker -> Ctrl+Alt+N

Marker Function Ctrl+Alt+F

Meas Ctrl+Alt+M

Meas Setup Ctrl+Alt+E

Menu (Alt) Alt

Mode Ctrl+Shift+M

Mode Preset Ctrl+M

Mode Setup Ctrl+Shift+E
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Mute Mute checkbox under the Volume 
Control

Next Window Ctrl+Shift+N

Peak Search Ctrl+Alt+P

Print Ctrl+P

Quick Save Ctrl+Q

Recall Ctrl+R

Restart Ctrl+Alt+R

Return Ctrl+Shift+R

Right Arrow Right Arrow

Save Ctrl+S

Select Space Bar

Single Ctrl+Alt+S

Softkey 1 Ctrl+Shift+F1

Softkey 2 Ctrl+Shift+F2

Softkey 3 Ctrl+Shift+F3

Softkey 4 Ctrl+Shift+F4

Softkey 5 Ctrl+Shift+F5

Softkey 6 Ctrl+Shift+F6

Softkey 7 Ctrl+Shift+F7

Source Ctrl+Alt+U

SPAN X Scale Ctrl+Shift+S

Split Screen Ctrl+Shift+L

Sweep/Control Ctrl+Shift+W

System Ctrl+Shift+Y

Tab Tab

Trace/Detector Ctrl+Alt+T

Trigger Ctrl+Shift+T

Table 7-9 Keycode commands

To initiate the following virtual key: Press these keys on the remote computer 
keyboard:
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Up Arrow Up Arrow

User Preset Ctrl+U

View/Display Ctrl+Shift+V

Zoom Ctrl+Shift+Z

1 1a

2 2a

3 3a

4 4a

5 5a

6 6a

7 7a

8 8a

9 9a

– Use the – key to enter a negative 
value, as appropriatea

. (Decimal Point) . (Period)a

0 (Zero) 0 (Zero)a

a. For remote keyboards that feature a numeric keypad, use either the appropriate numeric 
keypad key or the main keypad key.

The effect of pressing Ctrl+Alt+Delete on the keyboard of the remote 
computer always applies to the remote computer, and not to the test set. 
Generally, the effect of pressing this key combination is to display the Windows 
Task Manager. Therefore, pressing this key combination on the remote computer 
does not allow you to reboot the test set.

Table 7-9 Keycode commands

To initiate the following virtual key: Press these keys on the remote computer 
keyboard:
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Ending a Remote Desktop session

There are two ways to disconnect the remote computer from the test set to end 
the session:

Table 7-10 Ending the session

Step Notes

1 Click the X, then click OK. For full-screen, the X appears at the top center of 
the window.

For non full-screen, the X appears in a red box at 
the right of the window’s title bar.

2 Or, when the remote desktop is full screen, 
move the cursor to the bottom left of the 
window. 
Click Start > Disconnect. 
Click Disconnect. 

You are asked to confirm that you want to 
disconnect.
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The Virtual Front Panel

The Virtual Front Panel is a software equivalent of the front-panel key set, 
which provides another alternate method for test set control. It may be 
displayed in a separate window on the test set (or remote desktop) display. 

Using the mouse, right-click the application display window, then select Utility 
> Virtual Front Panel. The Virtual Front Panel appears, as shown below:

Figure 7-2 Virtual front panel keys

When you click a button in the Virtual Front Panel, it performs the operation of 
the corresponding test set front-panel key. The buttons at the left of the panel, 
named Softkey 1 through Softkey 7, perform the operation of the respective 
softkeys. The Up and Down keys perform the operation of the knob.

The Virtual Front Panel is also available when using the test set directly, 
provided that a mouse or other pointing device is attached to it.
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Programmatic Control of the Test Set
For information on how to send commands to the test set, using a VISA 
connection, see the X-Series Signal Analyzer Programmer’s Guide, which is 
available online at: 
http://www.keysight.com/find/mxa_manuals

The individual TRX instruments within the test set chassis are controlled using 
separate VISA connections; see “TRX Selection” on page 38. 

http://www.keysight.com/find/mxa_manuals
http://www.keysight.com/find/mxa_manuals
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Capturing/Printing Displays and Windows
You need an external keyboard and mouse to use this feature.

Table 7-11 Saving the desktop

Step Notes

1 Press Print Screen on the external 
keyboard.

This captures the desktop and saves it on the 
Windows clipboard.

2 Open a graphics application, such as 
Microsoft Paint. 

3 Paste the clipboard contents into the 
application window. 

The keyboard shortcut Ctrl + v will paste the 
contents of the clipboard.

4 Save the image in a file, and/or print it.  

Table 7-12 Saving the currently active window

Step Notes

1 Click on the window you want to capture. This activates the window.

2 Press Alt + Print Screen on the external 
keyboard. 

This captures the window and saves it on the 
Windows clipboard.

3 Open a graphics application, such as 
Microsoft Paint. 

4 Paste the clipboard contents into the 
application window. 

The keyboard shortcut Ctrl + v will paste the 
contents of the clipboard.

5 Save the image in a file, and/or print it.  
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Windows Shortcuts and Miscellaneous Tasks
This section provides a list of Windows shortcuts (key combinations) that are 
useful when you operate the test set without an attached mouse and keyboard. 
(See also “Navigating Windows Without a Mouse” on page 186.) Although 
these shortcuts are available in any Windows system, they are not commonly 
used when a mouse and keyboard are attached.

Windows shortcuts (key combinations)

You can use the following combinations of front panel keys to perform basic 
Windows tasks when using the test set without an attached mouse and 
keyboard.

Table 7-13 Windows shortcut key combinations

To do the following: Press:

Display the Windows Start Menu Ctrl+Esc

Cycle through all open applications Alt+Tab

Select the first menu of a menu bar Alt

Move through menu headings Left Arrow, Right Arrow

Open (drop down) a menu Down Arrow

Move through items in an expanded menu Up Arrow, Down Arrow

Close the current menu selection Esc

Cancel the current menu bar selection Alt

Open an application’s control menu (usually the left-most menu 
on the menu bar, starting with File)

Alt+Select

In a dialog: move between tabs Ctrl+Tab

In a dialog: move forward through dialog box items Tab

In a dialog: move backward through dialog box items Shift+Tab

In a dialog: open a list box Alt+Down Arrow

In a dialog list box or check box: select or deselect items Select

In a dialog list box or check box: select or deselect one item at a 
time

Shift+Up Arrow, Shift+Down 
Arrow

In My Computer, expand a selected folder Enter

In My Computer, open a folder one level up from the current 
folder

Bk Sp
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Navigating an Application Menu without a Mouse or Keyboard

This example uses Microsoft Excel, but you can use a similar sequence of 
operations to select and execute any menu item of any application.

To select and execute the item Sheet > Rename option from the Format menu 
in the menu bar shown below,

Figure 7-3 Format > Sheet > Rename

perform the following operations:

Table 7-14 Changing the sheet name

Step Notes

1 Press Alt to select the File menu in the menu 
bar.

The focus must be in the appropriate window.

2 Use the Right Arrow and Left Arrow keys 
to move horizontally to the Format menu. 

 

3 Press the Down Arrow to expand the 
Format menu. 

 

4 Use the Down Arrow and Up Arrow keys 
to move vertically to the Sheet menu item. 

 

5 Press the Right Arrow key to expand the 
Sheet sub-menu. 

The Rename sub-menu item appears already 
selected. If another item in the same sub-menu is 
required, use the Down Arrow and Up Arrow 
keys to move vertically to that item.

6 Press Enter to execute the selected action.  
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Windows taskbar auto-hide feature

The Windows taskbar should always be in the auto-hide mode when using the 
test set application. If the taskbar is not set to auto-hide, the lower part of the 
test set display is obscured by the taskbar. 

If a mouse is attached to the test set, and you move the mouse cursor to the 
bottom of the display (either deliberately or accidentally), the taskbar 
automatically appears. Provided that the taskbar is in auto-hide mode, you can 
make it disappear again by moving the mouse cursor away from the bottom of 
the screen.

If at any time the Windows taskbar is inadvertently set to the non-auto-hide 
mode, you can restore the auto-hide behavior by doing the following:

Table 7-15 Restoring taskbar auto-hide mode

Step Notes

1 Click Start > Control Panel If not using a mouse, press Ctrl+Esc.

2 Click Appearance and Personalization, 
Taskbar and Start Menu. 

If you are not using a mouse, use the shortcut key 
combinations specified in the Section 
“Windows shortcuts (key 
combinations)” on page 204 to make 
these selections.

3 Click the Taskbar tab. The Taskbar and Start Menu Properties 
dialog appears.
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4 Select the Auto-hide the taskbar check 
box.

If you are not using a mouse, press Tab 
repeatedly until the auto-hide option is selected, 
then press Select to toggle the check box state.

5 Click OK. This applies the change and closes the dialog 
box.

Table 7-15 Restoring taskbar auto-hide mode

Step Notes
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Windows startup folder

All Windows systems include a special folder, called the Startup folder. If a 
program, or a shortcut to a program, is placed in the Startup folder (either by 
Windows itself, or by a third-party application, or by any user), that program 
automatically runs every time Windows is restarted. 

When your test set is first configured by Keysight, shortcuts to the appropriate 
application software and supporting programs are placed in the Startup folder. 
The exact contents of the Startup folder depends on the options you purchased 
with your test set. 

If you wish to view the contents of the Startup folder, do one of the following:

— Either click Start, All Programs, then select Startup,  
or,

— Click Start, My Computer, then navigate to the folder: 
C:\Documents and Settings\All Users\Start Menu\Programs\Startup. 

Additional startup items may also appear in the corresponding startup folder 
for the user that is currently logged on. For example, the startup folder for the 
administrator user is C:\Documents and Settings\administrator\Start 
Menu\Programs\Startup.

You should never delete items that appear in the Startup folder, or move any 
item from the Startup folder to another folder. Deleting or moving any item in 
the Startup folder may cause applications not to start automatically when 
Windows is restarted, or may cause certain options to be unavailable when 
using the test set.
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8 Troubleshooting

The following topics can be found in this section:

“Check the Basics” on page 210

“Problems with Microsoft Windows Operating System” on page 212

“Returning a test set for Service” on page 213

No operator serviceable parts inside. Refer servicing to qualified personnel. To 
prevent electrical shock do not remove covers.
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Check the Basics

— Is there power at the receptacle? 

— Is the test set turned on? Check to see if the blue power light and the green 
fan LEDs beside the power switch are on and steady. Also, listen for internal 
fan noise to determine if the test set cooling fans are running. 

— If other equipment, cables, and connectors are being used with your test 
set, make sure they are connected properly and operating correctly. 

— If the test set cannot completely load or run the operating system, or the 
instrument application is not successfully launched, the problem could be a 
corrupt hard drive. If the test set gets far enough along in the boot process 
to run the "Keysight Recovery System", perform the “Hard Drive Recovery 
Process” on page 85. (The bootup process will be visible only if you have 
connected an external monitor.)

— Is the Measurement Application running? If not, there is a software launch 
shortcut/icon on the desktop.

— Does the test set application have the focus? (That is, is the blue window 
banner highlighted?) If not, move focus to the application with Alt-Tab.

— Review the measurement procedures being performed when the problem 
first appeared. Are all of the settings correct? 

— If the test set is not functioning as expected, return the test set to a known 
state by pressing Mode Preset.

— Is the measurement being performed, and the results that are expected, 
within the specifications and capabilities of the test set? Refer to the 
specifications in the data sheet for your test set, which is available on the 
Keysight website:  
http://www.keysight.com/find/e6640a

— If the test set is not communicating via the LAN connection, check the LAN 
cable connection at the front panel.

— To meet specifications, the test set must be aligned. Either the Auto Align 
(On) feature must be selected (press System > Alignments > Auto Align > 
Normal), or the test set must be manually aligned. 

— Perform an Alignment. Press System > Alignments > Align Now > All. 

Some test set settings are not affected by a Preset. If you wish to reset the test 
set settings, press System > Power On > Restore Power On Defaults.

http://www.keysight.com/find/e6640a
http://www.keysight.com/find/e6640a
http://www.keysight.com/find/e6640a
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— If the previously performed alignments did not resolve the problem, press 
System >Alignments > Restore Align Defaults. Then press System > 
Alignments > Align Now >All.

— Is the test set displaying an error message? If so, refer to the Instrument 
Messages Guide.

— Check if the external frequency reference is selected but not available. 
Verify that it is selected by pressing Input/Output > Freq Ref In. If External 
is selected, changing the setting to Sense allows the test set to sense the 
presence of an external reference and use it only if it is available. The 
frequency of the reference should be set correctly.

— If you are using a Windows program, other than the test set application, you 
may notice it running slow. Place the test set application in single 
sweep/measurement.

The test set must be powered on for 45 minutes prior to performing alignments.
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Problems with Microsoft Windows Operating System
The Microsoft Windows operating system settings have been optimized for the 
best performance. Modification of these settings may degrade test set 
performance and measurement speed. Those that can be safely modified are 
described in “Settings that can be changed” on page 73.

The E6640A EXM Wireless Test Set operates in an open Windows environment, 
so you can install software on the test set. However, installation of 
non-approved software may affect test set performance. Keysight does not 
warrant the performance with non-approved software installed.
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Returning a test set for Service

Read the Warranty 

The warranty for your test set is in the front of your Specifications Guide. 
Please read it and become familiar with its terms. 

If your test set is covered by a separate maintenance agreement, please be 
familiar with its terms. 

Service Options 

Keysight Technologies offers several optional maintenance plans to service 
your test set after the warranty has expired. Call your Keysight Technologies 
office for full details. 

Calling Keysight Technologies 

Keysight Technologies has offices around the world to provide you with 
complete support for your test set. To obtain servicing information or to order 
replacement parts, contact the nearest Keysight Technologies office listed in 
the following table. In any correspondence or telephone conversations, refer to 
your test set by its product number, full serial number, and software revision. 

Press System >Show > System, and the product number, serial number, and 
software revision information is displayed on your test set screen. A serial 
number label is also attached to the rear panel of the test set.

Locations for Keysight Technologies

For a listing of service locations, see http://www.keysight.com/find/assist

Contact us: http://www.keysight.com/find/contactus

http://www.keysight.com/find/assist
http://www.keysight.com/find/contactus
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Packaging the Test Set

Use original packaging or comparable. It is best to pack the unit in the original 
factory packaging materials if they are available.

You can repackage the test set with commercially available materials, as 
follows:

Test set damage can result from using packaging materials other than those 
specified. Never use styrene pellets in any shape as packaging materials. They do 
not adequately cushion the test set or prevent it from shifting in the carton. They 
cause test set damage by generating static electricity and by lodging in the test 
set louvers, blocking airflow. 

Step Notes

1 Wrap the test set in antistatic plastic 
to reduce the possibility of damage 
caused by electrostatic discharge.

2 Use a strong shipping container. The carton must be both large enough and strong enough 
to accommodate the test set. A double-walled, corrugated 
cardboard carton with 159 kg (350 lb) bursting strength is 
adequate. Allow at least 3 to 4 inches on all sides of the 
test set for packing material. 

3 Surround the equipment with three to 
four inches of packing material and 
prevent the equipment from moving 
in the carton.

If packing foam is not available, the best alternative is 
plastic bubble-pak. This material looks like a plastic sheet 
filled with 1-1/4 inch air bubbles. Use the pink-colored 
bubble which reduces static electricity. Wrapping the 
equipment several times in this material should both 
protect the equipment and prevent it from moving in the 
carton. 

4 Seal the shipping container securely 
with strong nylon adhesive tape.

5 Mark the shipping container 
“FRAGILE, HANDLE WITH CARE” to 
assure careful handling.  

6 Retain copies of all shipping papers. 
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